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Welcome to Universal Type Server 
Universal Type Server® is the next generation of workgroup font management software. Written for the 
latest operating systems, this cross-platform system combines the power, speed, and control that 
administrators need with the seamless font delivery and elegant interface that users expect.  

Type Server® provides the centralized control, consistency, and compliance for all levels of font 
management - administrators as well as client users. Administrators can rest assured that the appropriate 
fonts are available to the client when they need them, and rogue fonts are kept out of the workflow. 
Meanwhile, users are certain that they are using the correct, approved fonts for their projects by using the 
Universal Type Client™. 

About the Users and Workgroups Administration Guide 

After installing Universal Type Server and configuring any necessary networking settings in the instructions 
in the Server Administration Guide, the next step is to prepare the Type Server for your users. This guide 
covers all topics related to the configuration of workgroups, roles and users. 

This guide covers typical strategies for workgroup configuration, worksheets, as well as detailed instructions 
for all tasks that are completed through the Users and Workgroups Administration web interface.  
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Users and Workgroups Administration overview 
After installing Universal Type Server and performing any necessary configuration in the Server 
Administration web interface, the next step in the installation process is to plan your configuration, then 
create workgroups and add users. 

Workgroups are the large containers in which fonts are stored. Administrators provide user access to 
workgroups by adding users to workgroups. All workgroup and user tasks are performed through the Users 
and Workgroups Administration web interface. It is here that administrators create workgroups, user 
accounts as well as manage associated settings and permissions. 

The basic user and workgroup configuration steps include: 

1. Plan your configuration 
2. Create workgroups 
3. Create new users 
4. Add users to workgroups 
5. Assign workgroup roles to users 
6. Modify user settings as required 

After completing the steps above, you are ready to add fonts to workgroups using the Universal Type Client.  

Any font-related task - such as adding and deleting fonts, tagging fonts with keywords, tracking licenses, and 
activation - are accomplished using the Type Client. For detailed instructions, see the Universal Type Client 
User Guide and web help.  

Planning Your Configuration 

The mechanics of setting up Universal Type Server are not difficult. Adding workgroups, roles, and users are 
fairly simple matters. Yet, Universal Type Server can be configured in many different ways. To best meet the 
workflow needs of your organization, we recommend that you take a moment to plan how you'll configure 
your installation.  

To create the ideal solution in your environment, you need to think through all the fonts you have, where 
they’re from, what they’re for, who’s using them, and how they’re using them. To help with the setup, we 
describe several typical workflows along with detailed explanations of their workgroups, user permissions, 
and roles. Once you identify the most logical configuration, use the included workgroup and user worksheets 
to plan out your workgroups and users before creating your system. 

You may find that configuring a server for a small group of users helpful when determining the appropriate 
workgroups, roles, permissions and settings for your environment.  

Sample configurations 

While you can structure your workflow in any way you want, you’ll probably end up working with one of three 
common configurations: full access, project based, or department based.  

Organizing Fonts on a Department Basis  

If you have distinct groups of users that each require a different set of fonts, workgroups can be created for 
each department or group. This configuration is typical for companies with large numbers of users, such as 
magazines and book publishers. 

With this configuration, fonts are added to workgroups based on each group's specific font needs. For 
example, a publishing environment might contain workgroups for design, editorial, advertising, and 
production. The fonts contained in each workgroup as well as the workgroup default roles can vary 
according to the user's font needs. 
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For example, the editorial department would likely have a well defined and locked down set of fonts. Users 
in this workgroup just need to know that they have the correct fonts, and would not likely need much 
additional font organization. With the fairly restrictive Regular User role applied as the default workgroup 
role, the administrator can be sure that all users in the editorial workgroup have what they need, and aren't 
able to modify fonts.  

Organizing Fonts on a Project Basis 

With a project-based organization method you create workgroups for specific projects. This configuration is 
typical for companies with a medium to a large number of users, who typically work in teams, like design 
firms and ad agencies. 

With this configuration you might have a workgroup for each division, client, campaign, or other project. 
Type Server users are only added to workgroups to which they are required. This way each project is 
contained within its own workgroup, and users can be certain that they have the fonts required for a project.  

Providing Full Access  

This is the most basic way to set up Universal Type Server, yet works well in environments with very few 
users such as small design groups and prepress shops. Basically, all fonts are added to a single workgroup 
to which all users are members. Through the use of a fairly permissive default workgroup role, each user is 
given the ability to perform most actions with all of the server fonts.  

This method works great in situations where there isn't a dedicated IT administrator, and all of your users 
are fairly savvy. This workflow allows all users to have full access to all of the organization's fonts to 
complete their jobs. The downside of this method is that it doesn't scale well to fit larger workgroups, and 
has an inherent lack of control over keyword vocabulary as well as lack of control over which users can add 
and remove fonts.  

This method can work well if you're installing Type Server on a trial basis. 

Department Based Configuration 

Organizations with fairly structured departments that each have specific font needs can benefit from 
organizing fonts into department workgroups. This configuration is typical for companies with large numbers 
of users, such as magazines and book publishers. 

For example, a publishing company might have different workgroups for the editorial, layout, and production 
departments. The editorial department doesn't choose which fonts to use, yet for copy-fitting needs, it is 
imperative that they have the correct fonts for the job. The layout team needs access to all of the company's 
fonts to have creative control over the design of each project. And the production group needs access to 
most of the company's fonts as well as the ability to collect fonts for printing jobs. Using a department based 
configuration, each department has its own workgroup and default role for users. This way administrators 
can easily control the fonts and permissions available to each workgroup. 

Choose or Create Default Roles 

The first step is to write down a list of the required workgroups, and then create a list of default roles for 
each workgroup. The default role for a workgroup controls a base set of permissions for all users added to 
the workgroup. The predefined roles that come with Type Server may work well for you, yet if you require 
different default permissions it's best to create a custom role at this point.  

To display the permissions for each predefined role: 

1. Open the Users and Workgroups Administration web interface. 
2. From the Roles pane, select each predefined role to examine the default permissions settings. 
3. Write down a default role for each workgroup, or if required, create custom roles for your 

workgroups. Use the workgroups worksheet to help you define settings. For example, the 
Editorial workgroup might have Regular User as its default role, the Layout workgroup might 
have Font Administrator as the default role, and the Production workgroup might have a custom 
role that grants permission to add and remove fonts as well as collect fonts for output.  
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Create Workgroups 

Next, create the workgroups required for your projects or clients. 

1. In the Workgroups pane, click the Add (+) button. This opens the New Workgroup details 
pane.  

2. Enter a Workgroup Name for the workgroup. 
3. Choose a Default Role from the drop-down menu. Choose the default role that you wrote down 

in the workgroups worksheet. 
4. Click Saveto add the new workgroup. 
5. Repeat this process to create all necessary workgroups. 

Create Users 

The next step is to create all of the users and add them to the workgroups.  

To plan out each user's permissions, you may want to use the included user worksheet. Most likely, all of the 
permissions listed on the worksheet will be set by the user's role in the workgroup. Yet, if necessary, 
administrators can set each permission for users on an individual basis.  

To create a new user: 

1. In the Workgroups pane select your new workgroup. Selecting the workgroup ensures that new 
users are automatically added to this workgroup. 

2. In the Users pane, click the Add (+) button. 
3. In the New User details pane, in the Account tab, enter the basic account information: 

• Account Name - Each user account name must be unique. It's best to use an account name that 
is short, easy to remember and does not include spaces or letter case variations. 

• Full Name - required field. For ease of alphabetization, you can enter names in a "Last Name, 
First Name" format so that names can be easily sorted in the users pane. 

• Email Address - optional field. 
• Password - this case-sensitive field is optional. If left blank, a password is not required for this 

user to login. 
• Notes - enter any notes to appropriately identify the user.  

4. Click Save to add the new user. 
5. Repeat this process until all of your users are added.  

Add Users to Workgroups 

After adding users, users need to be assigned to each workgroup. 

1. In the Workgroups pane, select the All Users workgroup. 
2. To assign users to workgroups, from the Users pane, select the username and drag it to a 

workgroup. Users can belong to one or more workgroups.  

Delegate Roles 

After adding users to workgroups, you'll need to delegate roles for each workgroup. Each user is assigned 
the default role when added to the workgroup, yet each workgroup will likely need users who have elevated 
permissions within the workgroup. It is best to assign these permissions with user roles.  

When working with departments, you will need to have at least one person who is able to add, remove, and 
organize fonts within the workgroup. You can assign the Font Administrator role to users who need this 
ability.  
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If you have teams that are continually changing, and require the addition and removal of users from projects, 
you may need a Full Administrator for each workgroup. Full Administrators are able to login to the Users and 
Workgroups Administration web interface and manage users as well as manage server settings. Having 
additional Full Administrators can be handy if your teams are located in different time zones and you need to 
manage workgroups in a timely fashion. 

To delegate roles: 

1. In the Workgroups pane, select the workgroup name. 
2. From the Users pane, select the user that you want to update. 
3. In the Details pane, click the Workgroups tab. 
4. Select the workgroup name from the Show permissions for Workgroup drop-down menu.  
5. Choose a new role for this user in the selected workgroup from the Role in Workgroup drop-

down menu.  
6. Click Save. 

Configure User Settings 

After adding users, you need to determine the most appropriate font replication mode, synchronization and 
personal workgroup settings for each user. These settings control when fonts are brought down from the 
server to the client, and how long those fonts remain on the user's system. Typically, the default settings will 
work for most users, but for certain users exceptions can be made. These are configured on the Settings 
tab for each user. 

• The default time between server syncs should work for most installations. The exception may be 
a user who doesn't often need new or updated fonts. For these users, a longer synchronization 
interval can be set. 

• The Font Replication mode controls when fonts are copied from the server down to the client 
machine. The default mode is On-demand, which gives users fonts only when they need to 
preview or activate them. The On-demand setting is typically the best choice for client machines 
that stay in the office. For users who are working on laptops and may need to work offline 
frequently, set the font replication mode to All. This ensures that all fonts in the Type Server are 
downloaded to the client, and always available for use offline.  

• Enable personal workgroups for users who need to add and activate fonts that they won't need to 
share with the rest of the workgroup. Server-based personal workgroups can be very helpful for 
users who work on multiple machines and need access to the same personal fonts on each 
machine. Otherwise, it's a good idea to have all users always add fonts to the main workgroup, 
and use sets to further organize fonts as necessary. 

Add and Organize Fonts 

After configuring users, distribute account login settings to users. Those who have permission can now 
begin adding fonts to workgroups using the Type Client.  

For more information about adding, organizing, and managing fonts, see the Universal Type Client User 
Guide and web help. 

Project Based Configuration 

This configuration is typical for companies with a medium to a large number of users, who typically work in 
teams, like design firms and ad agencies. If you have projects or clients that are easily separated into 
groups, a project based configuration method might be best for you. 

For example, an agency that assigns employees to specific clients would benefit from having a workgroup 
for each client. Using this method, users who are working with a specific client are added to the client 
workgroup and thus have access to all fonts necessary for that client's projects. Further font organization is 
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available within each workgroup through the use of font sets. So, if you create a workgroup for each client, 
you can organize fonts within each workgroup by creating a set for each project you do for that client.  

Create Workgroups 

The first step is to create the basic workgroups required for your projects or clients.  

1. Open the Users and Workgroups Administration web interface. 
2. In the Workgroups pane, click the Add (+) button. This opens the New Workgroup details 

pane.  
3. Enter a Workgroup Name for the workgroup. 
4. Choose a Default Role from the drop-down menu. For project-based workgroups, it is best to 

choose the Regular User default role. Less restrictive permissions can be set later for specific 
users by delegating user roles for each workgroup. 

5. Click Save to add the new workgroup. 
6. Repeat this process to create all necessary workgroups.  

Create Users 

The next step is to create all of your users and add them to the workgroups.  

To create a new user: 

1. In the Workgroups pane select your new workgroup. Selecting the workgroup ensures that new 
users are automatically added to this workgroup. 

2. In the Users pane, click the Add (+) button. 
3. In the New User details pane, in the Account tab, enter the basic account information: 

• Account Name - Each user account name must be unique. It's best to use an account name that 
is short, easy to remember and does not include spaces or letter case variations. 

• Full Name - required field. For ease of alphabetization, you can enter names in a "Last Name, 
First Name" format so that names can be easily sorted in the users pane. 

• Email Address - optional field. 
• Password - this case-sensitive field is optional. If left blank, a password is not required for this 

user to login. 
• Notes - enter any notes to appropriately identify the user.  

4. Click Save to add the new user. 
5. Repeat this process until all of your users are added.  

Add Users to Workgroups 

After adding users, users need to be assigned to each workgroup. 

1. In the Workgroups pane, select the All Users workgroup. 
2. To assign users to workgroups, from the Users pane, select one or more user names and drag 

them onto a workgroup name in the Workgroups pane. Users can belong to one or more 
workgroups.  
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Delegate Roles to Users 

After adding users to workgroups, you'll need to delegate roles for users in each workgroup. Roles give 
users the ability to perform extra functions within a workgroup and are set on a user-by-user basis. Most 
users will do fine with the default role, while others will be assigned special abilities through the use of a 
different role.  

When working with projects, you will need to have at least one person who is able to add, remove and 
organize fonts within the workgroup. You can assign the Font Administrator role to users in each workgroup 
who need this ability.  

If you have teams that are continually changing, and require the addition and removal of users from projects, 
assign the Full Administrator setting to at least one user for each workgroup. Full Administrators are able to 
login to the Users and Workgroups Administration web interface and manage users. Having an additional 
Full Administrator can also be handy if your teams are located in different time zones and you need to 
manage workgroups in a timely fashion. 

Before assigning roles, click each role name in the Roles pane. If these roles do not meet your needs, you 
can create a custom role to assign to users.  

To delegate roles: 

1. In the Workgroups pane, select the workgroup name. 
2. From the Users pane, select the user that you want to update. 
3. In the Details pane, click the Workgroups tab. 
4. Select the workgroup name from the Show permissions for Workgroup drop-down menu.  
5. Choose a new role for this user in the selected workgroup from the Role in Workgroup drop-

down menu.  
6. Click Save. 

Configure User Settings 

After adding users, you need to determine the most appropriate font replication mode, synchronization and 
personal workgroup settings for each user. These settings control when fonts are brought down from the 
server to the client, and how long those fonts remain on the user's system. Typically, the default settings will 
work for most users, but for certain users exceptions can be made. These are configured on the Settings 
tab for each user. 

• The default time between server syncs should work for most installations. The exception may be 
a user who doesn't often need new or updated fonts. For these users, a longer synchronization 
interval can be set. 

• The Font Replication mode controls when fonts are copied from the server down to the client 
machine. The default mode is On-demand, which gives users fonts only when they need to 
preview or activate them. The On-demand setting is typically the best choice for client machines 
that stay in the office. For users who are working on laptops and may need to work offline 
frequently, set the font replication mode to All. This ensures that all fonts in the Type Server are 
downloaded to the client, and always available for use offline.  

• Enable personal workgroups for users who need to add and activate fonts that they won't need to 
share with the rest of the workgroup. Server-based personal workgroups can be very helpful for 
users who work on multiple machines and need access to the same personal fonts on each 
machine.I can also be helpful for users who may need to experiment with a few fonts for a project 
before purchasing a large number of licenses and adding those fonts to a workgroup for other 
users. Otherwise, it's a good idea to have all users always add fonts to the main workgroup, and 
use sets to further organize fonts as necessary. 
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Add and Organize Fonts 

After configuring users, distribute account login settings to users. Those who have permission can now 
begin adding fonts to each workgroup. Other client users are then able to activate and deactivate fonts as 
required for each project with the Type Client.  

For more information about adding, organizing, and managing fonts, see the Universal Type Client User 
Guide and web help. 

Full Access Sample Configuration 

The most basic way to configure Universal Type Server is to place all of your fonts into a single workgroup 
and allow all of your users a very permissive level of access to those fonts. This method sacrifices some of 
the administration control available in Universal Type Server for the benefits having users police their own 
actions with fonts on the server.  

Typically workgroups such as small design houses or prepress shops will choose this method of 
configuration. 

The following setup instructions contain the recommended way to setup your Type Server to allow full 
access for all users. Your process may vary based on your group's needs. 

Create the Workgroup 

The first step is to create the workgroup that will house all of your fonts. 

1. Open the Users and Workgroups Administration web interface. 
2. In the Workgroups pane, click the Add (+) button. This opens the New Workgroup details 

pane.  
3. Enter a Workgroup Name. This is the name displayed in the client, and is the location where all 

users will add and activate fonts.  
4. Choose a Default Role from the drop-down menu. Since all of your users will have the same 

level of access, it's a good idea to set a default role that isn't very restricting. Choose Font 
Administrator from the list. This will allow any user to perform necessary organization and 
maintenance tasks using the Type Client and also gives your users a wide variety of abilities to 
add, organize and tag fonts within workgroups. 

5. Click Save to add the new workgroup. 
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Create Users 

The next step is to create all of your users and add them to the workgroup.  

To create a new user: 

1. In the Workgroups pane select your new workgroup. Selecting the workgroup ensures that new 
users are automatically added to this workgroup. 

2. In the Users pane, click the Add (+) button. 
3. In the New User details pane, in the Account tab, enter the basic account information: 

• Account Name - Each user account name must be unique. It's best to use an account name that 
is short, easy to remember and does not include spaces or letter case variations. 

• Full Name - required field. For ease of alphabetization, you can enter names in a "Last Name, 
First Name" format so that names can be easily sorted in the users pane. 

• Email Address - optional field. 
• Password - this case-sensitive field is optional. If left blank, a password is not required for this 

user to login. 
• Notes - enter any notes to appropriately identify the user.  

4. Click Save  to add the new user. 
5. Repeat this process until all of your users are added.  

Configure Permissions 

Since the Font Administrator default role is set for your only workgroup, all users will have the permission to 
perform most actions with the Type Client. Notable exceptions include the ability to access the Server 
Administration and Users and Workgroups web interfaces. Typically, these functions are accessed only by 
an IT professional. If you don't have a specific IT person, you may wish to enable the Full Administrator 
global permission for one or more users. Otherwise, it is best to use the System Administrator Super-user 
account to login to the Server Administration and Users and Workgroups web interfaces.  

Configure User Settings 

After adding users, you need to determine the most appropriate font replication mode, synchronization and 
personal workgroup settings for each user. These settings control when fonts are brought down from the 
server to the client, and how long those fonts remain on the user's system. Typically, the default settings will 
work for most users, but for certain users exceptions can be made. These are configured on the Settings 
tab for each user.  

• The default time between server syncs should work for most installations. The exception may be 
a user who doesn't often need new or updated fonts. For these users, a longer synchronization 
interval can be set. 

• The Font Replication mode controls when fonts are copied from the server down to the client 
machine. The default mode is On-demand, which gives users fonts only when they need to 
preview or activate them. The On-demand setting is typically the best choice for client machines 
that stay in the office. For users who are working on laptops and may need to work offline 
frequently, set the font replication mode to All. This ensures that all fonts in the Type Server are 
downloaded to the client, and always available for use offline.  

• Enable personal workgroups for users who need to add and activate fonts that they won't need to 
share with the rest of the workgroup. Server-based personal workgroups can be very helpful for 
users who work on multiple machines and need access to the same personal fonts on each 
machine. Otherwise, it's a good idea to have all users always add fonts to the main workgroup, 
and use sets to further organize fonts as necessary. 
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Add and Organize Fonts 

Since all users have the ability to add fonts, you can now pass out the account access information to users 
and have users add fonts to the workgroup.  

For the best organization within your workgroup, ask users to add fonts into sets that can then be shared 
with all users to keep everyone in sync. 

For more information about adding, organizing, and managing fonts see the Universal Type Client User 
Guide and web help. 

Opening the Users and Workgroups Administration Web Interface 

Administrators manage users, workgroups, roles, and permissions using the Users and Workgroups 
Administration web interface. This interface can be accessed through any supported web browser.  

To open the Users and Workgroups Administration web interface: 

1. Open the Universal Type Client. 
2. Choose Server > Manage Users and Workgroups. The Users and Workgroups Administration 

web interface opens in the default web browser.  
3. Choose a display language from the menu. 
4. Enter a username and password and click Login. 

or 

1. Open a supported web browser. 
2. In the location bar, enter your server IP address followed by a colon and the port number. The 

default Users and Workgroups Administration port is 8080 (Also called the Jetty Web App 
port). For example: http://10.1.2.32:8080 or http://localhost:8080 if administering 
the server locally. 

3. Choose a display language from the menu. 
4. Enter a username and password and click Login.  

NOTE: The password field is case-sensitive, but the username field is not. 

NOTE: If you login with the System Administration Super-user account, for the most secure configuration, 
change the default System Administrator Super-user password as soon after installation as possible.  

NOTE: The default location to open the Server Administration interface is the same IP address, with the port 
number 18081. For example: http://localhost:18081 

SSL Security: The Universal Type Server Users and Workgroups Administration web interface includes a 
secure connection option through port 8443. See Implementing a Secure Connection in the Server 
Administration User Guide and webhelp for details about implementing your own security certificate.  

Changing the Display Language 

The language of the Users and Workgroups Administration web interface is automatically set to the 
language your web browser is set to use. The web interface supports administration in English, French, 
German, Italian, Japanese and Spanish. If your preferred language is not supported, the interface defaults to 
English. 

Change the display language from the drop-down menu on login screen of the Users and Workgroups 
Administration page.  

It's important to note that this only changes the language displayed in the Users and Workgroups 
Administration page. The client's user interface, as well as the Server Administration interface remain in the 
language currently selected for that each application. 
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Roles 
Roles control the permissions in the Global and Workgroup permission tabs of each user. Roles are 
basically a group of permission settings that can be applied simultaneously to a user that affects their 
abilities in the workgroup.  

Roles are dynamic in that when you change a role setting, all users who have that role in any workgroup are 
immediately affected. So, if you add or remove permissions to a role, be aware that everyone with that role 
setting will obtain updated permissions. User Roles are also quite powerful because they allow you to 
change the abilities of a large number of users in many workgroups at one time.  

Defining a User Role Strategy 

Roles and Workgroups 

Roles allow administrators to quickly set up multiple users with a standard set of permissions. Even more 
speed is gained by applying a Default Role to a workgroup. That way, every user who is added to the 
workgroup receives that default role.  

When organizing workgroups, you may want to organize fonts by what level of access that is required for 
users. Using this method, you can create your workgroups and assign a custom default role for each 
workgroup. This way, every user who is subsequently added to each workgroup is automatically assigned 
the default role. Users become almost secondary in this configuration.  

For example, if a newspaper editorial department needs a specific group of fonts, yet those fonts are well-
defined and these users won't need to choose new fonts, you can create a fairly restrictive role setting and 
set it as the default role for that workgroup. That way every user who is added to the workgroup will be 
restricted to using fonts as the administrator intends. 

Users, Roles and Workgroups 

A user's role can vary from workgroup to workgroup. A user may have the Font Administrator role in one 
workgroup, but only the Regular User role in another. After a user is added to a workgroup, that user's role 
can be changed as required. So, if the default role is set to Regular User, and you need this user to be the 
Font Administrator, you can change this setting in the user's Workgroup permissions tab.  

It's also important to note that permissions set by role can be easily overridden on a user-by-user basis for 
each workgroup. So if a user needs one extra permission for a workgroup it is easy to set. 

Roles and Fonts 

It's important to note that font information is stored on a server-wide basis. So, any changes to attributes, 
such as keywords and foundry information, are applied across all workgroup. So, it is important that you 
choose roles and permissions for your users appropriately.  

For example, a user has the Font Administrator role in one workgroup, but only the Regular User role in 
another. That user can make changes to font attributes in workgroup where he is a Font Administrator. If a 
font exists in both workgroups, any changes to a font that the user makes as the Font Administrator will also 
appear in the other workgroup. 
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Custom Roles 

In most instances, the predefined roles that come with Type Server should meet most needs. If you need to 
set specific role settings, you can easily create a custom role.  

For example, a production environment could require special settings for everyone in the department. Those 
in the production department interface with outside clients, who supply fonts with their documents. These 
users may need to add fonts to the database, as well as collect fonts for use on other systems. In this case 
you could create a "production" workgroup and an associated custom role for use with that workgroup. This 
custom role would have permissions that allow the addition and deletion of fonts, as well as the ability to 
collect fonts for output. The default role for the "production" workgroup would be set to use this new custom 
role. Now, all users who are subsequently added to the workgroup have the appropriate permissions for that 
workgroup. The administrator would never need to modify custom permissions for "production" workgroup 
users, because anyone who is added to the workgroup automatically has the appropriate permissions. 

Predefined Roles 

To facilitate a quick and easy setup, Universal Type Server contains two predefined user roles. These roles 
are configured with commonly used settings, and can be used as-is or a starting place to think about your 
own custom roles.  

It's also important to remember that permissions may be granted that override role-based settings that are 
more or less permissive on a user-by-user basis.  

 
Predefined roles can be modified to meet your needs, but if you need different settings it is best to create a 
custom role.  

Regular User  

The Regular User predefined role is configured for users who are mostly interested in finding and activating 
fonts. A regular user might not spend much time using the Type Client, and allow the auto-activation plug-ins 
to activate and deactivate fonts as required for each document and project.  

Regular users can activate and deactivate fonts in workgroups for which they are members, apply keywords 
to fonts, and collect fonts for output. 

The Regular User predefined role is the default role for workgroups in which a default role is not assigned. 
This means that any user added to a workgroup that does not have a default role set will automatically 
receive the Regular User role assigned for that workgroup. 
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Font Administrator  

The Font Administrator predefined role is configured for users who need a higher level of control over fonts 
in a workgroup. Users who are required to add fonts, and perform other organizational tasks such as 
assigning keywords and creating shared sets, should have the Font Administrator role. 

Those with the Font Administrator role can do everything the Regular User role can do as well as:  

• Add and remove fonts.  
• Create and delete shared sets. 
• Modify shared sets. 
• Create, delete and apply keywords, styles, classifications, foundries and font licenses. 
• Activate fonts across multiple workgroups. 
• Modify font family groupings. 

Since roles are set by workgroup, users may be members of multiple workgroups yet are assigned the Font 
Administrator role in only a few workgroups.  

It's important to note that if a font information is stored on a server-wide basis. So if a font exists in multiple 
workgroups, and a user has the Font Administrator role in one workgroup, any changes made to the font as 
the Font Administrator will also appear in every other workgroup.  

Resetting Predefined Roles 

If you have modified the predefined settings of the Regular User and Font Administrator roles, these settings 
can be reset back to the default factory settings. Users with unmodified predefined role settings have their 
settings reset. Any specifically modified user permissions are kept. 

To reset a predefined role: 

1. Open the Users and Workgroups Administration web interface. 
2. In the Roles pane, click to select the predefined role to revert. 
3. Click the Reset button. 

Creating Roles 

If you require roles not met by the predefined roles, you can easily create custom roles. 

To create a new role:  

1. Open the Users and Workgroups Administration web interface. 
2. In the Roles pane, click the Add (+) button.  

 
3. In the Details pane, enter a role name.  
4. Enable or disable user permissions for the new role.  
5. Click Save  to save the new role.  
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Assigning Roles 

There are a two ways to assign user roles within a workgroup: 

• Using a workgroup's default role 
• Changing the user's workgroup permission setting 

Setting a Workgroup's Default Role 

The easiest way to assign user roles is to have the workgroup do it for you. By setting a default role for a 
workgroup, that role is automatically assigned to each user subsequently added to the workgroup. 

To set the default role for a workgroup: 

1. Open the Users and Workgroups Administration web interface. 
2. From the Workgroups pane, select the workgroup. 
3. In the Details pane, choose a role from the Default Role drop-down menu and click Save. 

Existing members of the workgroup are not affected by the workgroup's default role change. Only users who 
are subsequently added are assigned the new default role. 

Assigning Roles by User 

After users are added to a workgroup, you can update each user's role on a workgroup-by-workgroup basis. 
This is often necessary if a user was given the default role when added to a workgroup, and you want to 
assign a different role. 

To update the role for a user in a workgroup: 

1. Open the Users and Workgroups Administration web interface. 
2. From the Workgroups pane, select the workgroup. 
3. In the Users pane, select the username. 
4. In the Details pane, select the Workgroup tab 
5. From the Show Permissions in Workgroup drop-down menu, if it is not already selected, 

choose the workgroup for which you need to modify the role.  
NOTE: Only workgroups for which the user is a member are displayed. 

6. Choose a new role from the Role in Workgroup drop-down menu. 
7. Click Save. 

Deleting a Custom Role 

Depending upon your configuration, you may find that a custom role no longer suits your needs. Unlike the 
predefined Regular User and Font Administrator roles, custom roles can be deleted as necessary. 

If a custom role is currently assigned to a user when deleted, that user's role in any relevant workgroup is 
immediately set to the Regular User predefined role. Any custom user permissions that are not role-based 
are retained by the user. This might cause a severe reduction in user permissions, yet provides the most 
security. Deleting a custom role can also be used as an efficient way to immediately revert a group of users 
to a more restrictive access level. 

To delete a custom role: 

1. Open the Users and Workgroups Administration web interface. 
2. In the Roles pane, click to select the custom role to delete. 
3. Click the Remove (-) button and click OK to confirm removal. 
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Workgroups 
In Universal Type Server, fonts are organized into workgroups — collections of fonts intended for a specific 
job description, division, publication, or other grouping. Workgroups are like separate databases of fonts, 
each with its own group of users. The system administrator decides which users belong to each workgroup, 
and modifies user permissions on a user-by-user basis for each workgroup. To help facilitate setting user 
permissions, each workgroup has a default role, which sets the initial permissions for users added to the 
workgroup. 

Users can be members of one or more workgroups, and a user’s capabilities can vary from workgroup to 
workgroup. So, a user could be able to add and remove fonts in one workgroup but not in another.  

To maintain any existing organization you have for fonts, you can add collections of fonts to Universal Type 
Server as workgroups. For example, if your fonts are organized by department, you can create department-
based workgroups. For example teams for each account, magazine division or publishing team could have 
their own workgroups. You can also create new workgroups using fonts already in other workgroups and 
you can change which fonts are in which workgroups.  

Not to be confused with font sets — subsets of fonts within a workgroup— workgroups go beyond grouping 
fonts to controlling usage and access. 

When you create users, you specify workgroups to which they belong. In many configurations, users will 
belong to only one workgroup (although they can simultaneously belong to and activate fonts in multiple 
workgroups).  

For example, a magazine publisher may have three font workgroups — Editorial, Art, and Production.  

• The  Editorial workgroup contains fonts used in body copy. Writers and editors are members of 
this workgroup, and are given the permission to activate fonts, but aren't allowed to add, delete, 
or collect them.  

• The Art workgroup contains all of the fonts that the company owns; the graphic designers can 
activate and add fonts, but they can’t delete or collect them.  

• The Production workgroup encompasses all of the company’s fonts along with all of its 
advertisers’ fonts. Users of this workgroup are given permission to add, delete, and collect fonts.  

 
Some environments choose a simpler approach and only create one workgroup to which all fonts are added, 
and all required employees are added as users. In these environments, it's a good idea to create a custom 
role that allows users appropriate access to fonts, and set that role as the default for the workgroup. 
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Defining a Workgroup Strategy 

Before you start creating workgroups of fonts, you need to decide how you want to structure them. Unlike 
the way you probably have been managing fonts — by font name, foundry, etc. — think more about who 
needs the fonts than about characteristics of the fonts.  

For example, don’t create workgroups based on font characteristics such as foundries or classes. If you do, 
most of the users will end up needing access to fonts in many workgroups, making access difficult to 
manage. Users are able to sort fonts based on foundry and class in the Universal Type Client, so there is 
little need to organize fonts by foundry in separate workgroups.  

Another important consideration when planning workgroups is that, in general, each document you design or 
output should use fonts from only one workgroup. So each workgroup should contain all the fonts necessary 
to complete the projects its users are involved in. Although users can belong to and open multiple 
workgroups, this can cause a great deal of confusion, especially if you have various versions of the same 
font in different workgroups. 

It is easiest to select a sample configuration example and follow the detailed instructions for setting up your 
workgroups using one of these models. If your environment differs and requires a specialized configuration, 
spend a few minutes examining the fonts required in your environment as well as your user's font needs. 
Use the workgroups worksheet to help you plan and think through your configuration.  

Creating and Editing Workgroups 

New workgroups are created through the Users and Workgroups Administration web interface.  

To create a workgroup: 

1. Open the Users and Workgroups Administration web interface. 
2. In the Workgroups pane, click the Add (+) button. This opens the New Workgroup details 

pane. 
3. Enter a Workgroup Name. This is the name that is displayed to users who are members of the 

workgroup. 
4. Choose a Default Role from the drop-down menu.  

The default role is set for users when they are added to the workgroup. When used properly, the 
default role can make adding users and configuring permissions for a workgroup a snap. 

5. Enter any Notes to help you identify the fonts that will be contained in this workgroup. Notes are 
only visible in the Users and Workgroups Administration web interface, and are not visible in the 
client. 

After creating a workgroup, the next step is to add users to that workgroup. After adding users, those who 
have the appropriate permissions can add fonts to the workgroup using the Universal Type Client. It's 
important to remember that anything to do with the physical manipulation of fonts is performed using the 
Type Client. 

After creating a workgroup, you may find that there’s another name that more accurately describes the 
workgroup. You can easily change this as well as the default role after a workgroup is created. 

To edit an existing workgroup: 

1. Open the Users and Workgroups Administration web interface. 
2. In the Workgroups pane, select the existing workgroup. 
3. In the Detail pane, change the workgroup name and/or default role and click Save. 

NOTE: Any changes to the default roles affect only users subsequently added to the workgroup, and do not 
affect users who are currently members of the workgroup. 
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Deleting a Workgroup 

When a workgroup no longer serves a purpose, you can delete it. It’s important to understand what happens 
to fonts contained within a workgroup when it is deleted.  

• The users assigned to that workgroup remain in Universal Type Server. 
• The workgroup is removed from the list in the Universal Type Client as well as from the Users 

and Workgroups Administration interface.  
• If users have fonts from the workgroup active, the fonts stay active until the users shut down their 

computers or choose Server > Forget Connection. 
• If fonts in the deleted workgroup belong to other workgroups, they remain in the Type Server 

datastore. 
• If fonts in the deleted workgroup were exclusive to that workgroup, the fonts are deleted from the 

server entirely.  
• All font sets within the workgroup are deleted.  

To delete a workgroup:  

1. Open the Users and Workgroups Administration web interface.  
2. In the Workgroups pane, select the workgroup name. 
3. Click the Delete (-) button  
4. Click OK to confirm. 

The "All Users" Workgroup 

As its name indicates, the All Users workgroup displays a list of all of the users who have access to the 
Universal Type Server.  

All users belong to this workgroup, even if they are not a member of any other workgroup. However, to have 
access to server fonts, a user must be a member of a workgroup that contains fonts. The All Users 
workgroup does not contain any fonts, and is never visible in the Type Client. 

Most importantly, this All Users workgroup includes the System Administrator Super-user account under the 
name "administrator." The All Users workgroup is the only location from which the Super-user can change 
his or her password.  

The All Users workgroup cannot be deleted. 

NOTE: You must login as the Super-user in order to modify the Super-user password.  
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The All Fonts Workgroup 

The All Fonts workgroup displays all of the fonts contained in all of the Universal Type Server workgroups. 
The All Fonts workgroup functions as follows: 

• Viewing all fonts - The All Fonts workgroup does not appear in the list of workgroups available 
in the Users and Workgroup Administration web interface. Only Full Administrators are able to 
view the All Fonts workgroup in the Universal Type Client. 

• Adding fonts - Fonts are not added directly to the All Fonts workgroup. A font must belong to 
any other workgroup to remain in the All Fonts workgroup. If the only instance of a font is 
removed from another workgroup, then it is removed from the Type Server database. In this 
sense, the All Fonts workgroup is a virtual workgroup.  

• Deleting fonts - If a font is removed from the All Fonts workgroup, it is subsequently removed 
from all other workgroups. This is a good way for Full Administrators to remove outdated fonts 
from the workflow and prevent future use. 

• Duplicate handling - There are no true duplicates in the All Fonts workgroup. Fonts can have 
the same name, but if they are different versions, foundries, and so forth they are not considered 
a true duplicate. Only one copy of a the font is retained. Each font can belong to as many 
workgroups as necessary. For example, if a magazine’s body copy is always in Concorde Nova, 
this font would be added to all of the workgroups in the Type Client. Behind the scenes, the 
Universal Type Server is serving the identical font to all users of each workgroup. 

Workgroups Worksheet 

Workgroup name:   
Default role:_________ ______________________________________ 
Users in workgroup:   
    
    
    
    
    
    
   
 Fonts in workgroup:   
    
    
    
    
    
    
    
    
Notes:   
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Users 
A user is any individual who needs to connect to Universal Type Server to access fonts. Each user will have 
his own unique account name, settings and permissions.  

You can add as many users as required to the Type Server, regardless of how many user connections you 
have purchased. Your license simply controls how many concurrent connections are allowed to the server. 
Therefore, you can create a user for anyone who needs access to fonts— every full-time employee, part-
time employee, intern, client, etc.  

When creating users, the administrator specifies all basic user login information: username, full name, email 
address, password, and so forth.  

After the user is created, users are then added to workgroups. When a user is added to a workgroup, the 
user is automatically assigned the default role in that workgroup. The default workgroup role sets a wide 
variety of user permissions, and is handy for quickly setting consistent permissions for all users in a 
workgroup. If special user permissions are required, they can be set globally for that user or on a workgroup-
by-workgroup basis.  

User logins can be used with the Universal Type Client on either Mac OS X or Windows. The client is only 
able to use font files that are compatible with the current operating system, so users who work on both 
platforms may have different fonts available for use. For example, Windows-based PostScript fonts are not 
compatible with the Mac OS, so these fonts cannot be activated or collected by the Mac OS client.  

NOTE: To prevent confusion, control access, and aid in troubleshooting, do not give multiple users the same 
account name. For example, if you give all graphic designers the account name “Creative,” it will be difficult 
to determine who just added an unlicensed font. In a 24/7 environment, be sure to have a different account 
name for each user. 

Creating and Editing Users 

Users can be added by Full Administrators and the System Administration Super-user. 

To create a new user: 

1. Open the Users and Workgroups Administration web interface 
2. In the Workgroups pane select a workgroup to which you would like to add a user. To add a 

user without specifying a workgroup, select the All Users workgroup.  
3. In the Users pane, click the Add (+) button. 
4. In the New User details pane, in the Account tab, enter the basic account information: 

• Account Name - Each user account name must be unique. It's best to use an account name that 
is short, easy to remember, and does not include spaces or letter case variations. 

• Full Name - Optional field. 
• Email Address - Optional field. 
• Password - Optional field. If left blank, a password is not required for this user to login. 
• Notes - Enter any notes to appropriately identify the user. This information is only visible in the 

Users and Workgroups Administration web interface. 

5. Click Save to add the new user. 

After creating a new user, add the user to workgroups as required.  

Typically, default user settings are all that is required for most users. The appropriate user permissions are 
configured by the default workgroup role when you add this user to a workgroup. Although many settings 
and permissions options are available to modify on a user-by-user basis, it's likely that you will never need to 
do so.  
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NOTE: All font manipulation happens in the Universal Type Client. Add fonts, remove fonts, add keywords, 
organize fonts into sets and so forth using the Type Client. 

You can edit the user account information, settings, and permissions after the user is created.  

To edit an existing user: 

1. Open the Users and Workgroups Administration web interface 
2. In the Workgroups pane select any workgroup to which the user belongs.  
3. In the Users pane, select the user to edit. 
4. In the Details pane, click Edit. 
5. Update any of the user account information, settings and permissions. 
6. Click Save. 

Adding Users to Workgroups 

For a user to have access to fonts in a workgroup, the user must first be added to the workgroup. New users 
can be added directly into a workgroup when the user is created, or for users who already exist in the Type 
Server, the username can simply be dragged into the new workgroup.  

To add an existing user to a workgroup: 

1. Open the Users and Workgroups Administration web interface 
2. In the Workgroups pane, select the All Users workgroup, or any other workgroup to which the 

user currently belongs. 
3. From the Users pane, click and drag the username into any other workgroup. The user is 

automatically assigned the default role in the new workgroup.  
4. As required, you can now edit the user's permissions for the new workgroup in the Workgroup 

tab. 

Importing Users from a TXT file 

A fast way to create multiple user accounts at one time is to import a list of users from a tab-delimited text 
(TXT) file. This way administrators can quickly set up users before adding them to workgroups.  

The text file must be formatted to include tab-delimited information, in order, with line breaks between users. 
To import properly, the TXT file must be saved in as ASCII text with UTF-8 encoding.  

The only required field is the User account name. All other fields may be left blank if desired. 

• User account name 
• User full name 
• Email address 
• Notes 
• Password 
• Role 
• Workgroup 

For example: 
jsmith<tab>Smith,John<tab>jsmith@domain.com<tab>MyNotesHere<tab>johnspassword<t
ab>ContractorRole<tab>DesignersWorkgroup<line break> 

To skip a field, but to enter other information, simply put extra tabs between the fields. For example, to enter 
a User account name and Password only: 
jsmith<tab><tab><tab><tab>jsmithpassword<line break> 
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Multiple workgroups can be assigned by adding them at the end of each line, before the line break. For 
example, to add two workgroups named Design and Production to the user in the example above, the end of 
a new would be: 
...jsmithpassword<tab>Font Administrator<tab>Design<tab>Production<line break> 

In the example above, John Smith would be added to both the Design and Production workgroups and given 
the Font Administrator role in both workgroups.  

NOTE: To make it easy to create a properly formatted TXT file, use the Export feature from your 
spreadsheet editor, such as Microsoft Excel.  

To import a list of users: 

1. Open the Users and Workgroups Administration web interface. 
2. From the Users and Workgroups menu, choose Import Users from Text File. 
3. Click Import Users from File. 
4. Navigate to the tab-delimited text file to import, select the file and click Select (Mac) or Open 

(Win).  

Configure default server settings 

Two settings affect how and when fonts and other data are synchronized between the Universal Type 
Server and client machines. Default settings can be applied at any time.  

To configure default server settings: 

1. Open the Users and Workgroups Administration web interface. 
2. From the Options menu at the top of the screen, choose Default User Settings.  
3. From the Time between server syncs drop-down menu, choose a synchronization interval. This 

setting controls how frequently the client checks for updates from the server. The default is every 
5 minutes. If the fonts in your environment change infrequently, an hourly or daily setting may be 
all you need. Less frequent synchronization uses fewer server resources. 

4. From the Font Replication Mode drop-down menu, choose a replication mode. 
5. Click Save to apply the new default server settings. 

NOTE: To apply user permissions to multiple users at once, create and apply a role to users in a workgroup.  

Settings 

User settings control a number of options about how users are given access fonts, as well the enabling of 
administration privileges. This includes: 

• The Is Full Administrator setting allows users to access the "All Fonts" workgroup as well as 
access the Server Administration and Users and Workgroups Administration web interfaces. 

• The Time between server syncs setting controls how often fonts are downloaded, or 
synchronized with the Type Server. 

• How fonts are stored on the client's system is controlled by the Font Replication Mode setting. 
• Personal font workgroups are enabled through user settings.  
• The ability to change the user's own password is a user setting.  
• Disable Startup Sets so that the user is not subject to having all fonts in startup sets activated 

upon login. 
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The Full Administrator Setting 

The Is Full Administrator setting allows a user to perform most of the server administration tasks through 
both the Server Administration web interface and the Users and Workgroups Administration web interface.  

For each Type Server, typically only one or two users will have the Is Full Administrator setting. Full 
Administrators can perform all administration functions, yet cannot create other Full Administrators. The Is 
Full Administrator setting can only be set by the System Administrator Super-user.  

Full Administrators are users who are primarily responsible for the high-level workgroup and user 
organization, and are likely members of the IT department.  

The Is Full Administrator setting allows a user to: 

• Access and use all administration tools from the Server Administration web interface. 
• Create and delete users in any workgroup. 
• Modify permissions and settings for any user in any workgroup. 
• Rename and regroup font families. 
• Delete any sets that have been shared by other users.  

Synchronization 

To keep all of the fonts, font attributes, and user permissions current in all Universal Type Clients, the client 
synchronizes data with the server on a periodic basis. 

How often each user account synchronizes with the Universal Type Server is controlled by the Time 
between server syncs user setting. This setting is adjustable so that administrators can help minimize 
network traffic while ensuring that all clients are kept up to date.  

Synchronization takes place only while the client is connected and working online with the Type Server. 
After working offline, the client automatically synchronizes with the server, downloading all attribute changes 
and permissions. Fonts are downloaded to the client based on each user's Font Replication Mode.  

The synchronization interval for each user can vary based on that user's needs. For example all users of a 
production department may work on the same project at the same time. All of these users will need the 
same fonts at the same time, so a very short synchronization interval would benefit this environment. 
Alternately, a copy editor who works on just a few projects with a fairly static group of fonts would not need 
to be constantly synchronizing with the server. A longer interval, perhaps daily, would be more appropriate 
for this user.  

A more frequent synchronization setting can create unnecessary network traffic and potentially slow down 
your network. So, set your synchronization frequency to the a longer interval to keep network traffic to a 
minimum. 
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Font Replication Mode 

The Font replication mode setting controls when fonts are downloaded to the client system. Font 
replication is important to understand to keep your network traffic to a minimum and to maintain healthy 
server performance. 

 Depending upon the type of use that you expect, and to minimize network traffic, each user may have a 
different replication mode.  

• All - This replication mode automatically downloads all fonts from the workgroups to which the 
user is a member. This is a good setting for users who will frequently be working offline, and who 
need access to a wide variety of fonts.  

• On-Demand - This mode downloads fonts as they are required. Previewing, activating and 
collecting fonts initiates the download of selected fonts to the client machine. When fonts are no 
longer required, they are removed and are not stored in the Type Client font cache. Only fonts 
that are currently active or being previewed are available while working offline. 

• On-Demand Local Cache - This replication mode downloads fonts to the client as they are 
requested. Previewing, activating, and collecting fonts all initiate the download of a font. After 
being downloaded from the server, fonts are not removed and remain in the Type Client cache. 
Cached fonts are available for activation, preview, and collection while working offline. 

Font Replication and Licensing Issues 

The font replication mode that you choose can be affected by how you expect to account for the licenses for 
your purchased fonts. Fonts are each small pieces of software, each with their own license. You may have 
purchased fonts as part of a large library or one at a time. Either way, you need to be sure that you're using 
fonts in a way that you aren't compromising the font's license. 

• The All replication mode downloads all workgroup fonts to a user's system. Each and every font 
in workgroups to which the user is a member is always downloaded to the user's system, and 
thus may require a license for that font file.  

• The On-Demand replication mode only downloads files to a user's system when they are 
required. When the font is no longer in use, it is removed from the system and no longer 
consumes a font license.  

• The On-Demand Local Cache mode only downloads fonts as requested. So, if a user has 
previewed or activated a font, it is considered in-use by the system, and consumes a font license 
at that point. Since fonts are not removed from the user's system, all fonts remaining on the 
user's system continue to consume licenses. 

Personal Workgroups 

At the discretion of the administrator, users can add fonts to their own personal workgroup. Personal 
workgroups can be either server-based or client-based.  

• Server-based personal workgroups are available on any machine that the user logs in to. This 
is a good setting if you want to be sure that personal workgroups are available from any machine 
where the user logs in, and to ensure that there is always a backup of personal workgroup fonts 
on the server. 

• Client-based personal workgroups are housed only on a single machine so the fonts 
contained within these workgroups can vary from machine to machine for the same user 
account. Client-based workgroups have the advantage that if a user attempts to add corrupt 
fonts, the corrupt fonts are placed into a "corrupt fonts" set within the client-based personal 
workgroup.  
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Personal workgroups are useful when experimenting with fonts for which you may only have a single 
license. For example, say a graphic designer who is working on a new client’s identity is experimenting with 
fonts that are not part of the company’s licensed font library. The designer believes the fonts are ideally 
suited to the job and the administrator does not want to squelch the designer’s creativity. But, since the 
company doesn’t yet own a large number of licenses for this font, you don’t want to add them to the server 
for an entire workgroup to use. The solution is to have the designer add the fonts to his or her personal 
workgroup. If the client approves the fonts, you can purchase additional licenses and add the fonts to the 
appropriate workgroups. 

Access to a personal workgroup is a user-based permission, so some users might have them while others 
do not. For example, graphic designers are likely to need a personal workgroup, but editors are not. Since 
the fonts are for private use, users can add, delete, activate, add attributes and collect for output from their 
personal workgroup. 

NOTE: Personal workgroups are provided for special cases in which graphic designers absolutely need to 
use certain fonts right away. Since the use of personal workgroups limits the administrator’s control over 
who uses which fonts, they are not recommended for general, everyday use. 

WARNING: Changing the personal workgroup setting after a user has already added fonts and sets to that 
workgroup will result in the deletion of all existing fonts and sets in that user's personal workgroup. It is best 
to set the personal workgroup setting when adding a user and not modify it after a user has started to work 
with the personal workgroup. 

Change Password 

The Change Password setting allows the user to update their password directly from the Universal Type 
Client by choosing Server > Change Password. 
Alternately, Full Administrators can change a user's password directly through the Users and Workgroups 
Administration web interface. 

NOTE: If you are bound to a directory service and using Kerberos for single sign-on, the Change Password 
command does not have any affect on domain passwords. This command only affects Universal Type 
Server passwords.  

Activate Fonts Across Workgroups 

All users are able to simultaneously activate fonts in any workgroups to which they are a member. The 
Activate Fonts Across Workgroups setting applies only to the auto-activation plug-ins installed on the client's 
system. 

The Universal Type Server plug-ins are typically limited to activating fonts from a single workgroup. When 
the user launches an application for which the Type Server plug-in is enabled, the user is prompted to select 
a workgroup of fonts to use for auto-activation. Enabling this permission allows the plug-ins to activate fonts 
from workgroups to which the user has access and are enabled in the plug-in. 

Due to the fact that you can't guarantee that all users will have access to all fonts, it is best to design 
documents to only use fonts from a single workgroup. This way you can guarantee that all users of that 
workgroup will have the fonts necessary for the document. The risk of enabling this feature is that a user 
could unintentionally create a document that uses fonts from multiple workgroups. 

Enforce System Font Policy 

System Font Policies are used to control which fonts can be added to the system font folder on a user's 
machine.  

When a system font policy is enforced for a user, the Universal Type Client periodically checks which fonts 
are in the system font folders and removes any unapproved fonts.  

For complete details about System Font Policies, see Creating a System Font Policy. 
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Disable Startup Sets 

This permission disables the activation of startup sets for the selected user. You may want to do this for 
users who may be part of a workgroup, but not need to activate fonts that are typically activated for all users 
of the workgroup by startup sets.  

Users will still see startup sets in their workgroup, but the fonts are not be automatically activated. Fonts in 
these sets can be manually activated if desired.  

Updating user settings for multiple users 

Settings can be updated for multiple users at the same time by selecting multiple users in the Users and 
Workgroups Web Administration interface.  

NOTE: You may want to also designate default server settings that are automatically applied to users as 
they are created.  

The following settings may be changed for multiple users at the same time: 

• Change password 
• Activate fonts across workgroups 
• Time between server syncs 
• Font replication mode 
• Has Personal Workgroup (server-based or client-based) 
• Enforce System Font Policy 
• Disable Startup Sets 

NOTE: The "Is Full Administrator" setting and other account settings such as password, full name, notes, 
and so forth cannot be updated for multiple users at the same time. It is also important to note that users 
who are currently full administrators cannot be updated in a group with other users, and must be updated 
individually. 

To edit the user settings for multiple users: 

1. Open the Users and Workgroups web interface. 
2. In the workgroup pane, select a workgroup. 
3. In the Users pane, select multiple users by shift-clicking the first and last users, or by Ctrl-clicking 

(Win) or Cmd-clicking (Mac) multiple users in the list. 
4. In the Details pane, select the settings to apply or remove from all selected users and click Save.   

NOTE: Use the Roles feature to quickly apply and update permissions for multiple users. 

Permissions 

Permissions control what a user is allowed to do in workgroups. Permissions can be set globally, so that 
they affect all workgroups for a user, or on a workgroup-by-workgroup basis.  

Permissions control the ability to: 

• Add and remove fonts 
• Collect fonts for output 
• Create, delete and modify shared sets 
• Create and delete startup sets that are permanently active for all users 
• The ability to create, delete and apply attributes to fonts 

In most cases, it is best to allow permissions to be set by the user's role within each workgroup. Yet, for 
some users, you will need to specifically edit user permissions. Typically, you will need to edit permissions 
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for users who need extra abilities within a workgroup. For example, in a workgroup where all users are given 
the Regular User default role, you may want to give one user responsibility for creating and applying font 
licenses. To do so, for this user the administrator would grant the Create and Delete and Apply to Fonts 
permissions for Licenses. 

Global Permissions 

Global permissions grant users permission to perform actions across all workgroups to which the user has 
access. 

All global permissions are set by the user's role within each workgroup, and using roles is the recommended 
method for applying user permissions.  

Though, there may be some instances where you want to globally grant a single user extra responsibilities 
across all workgroups. For example if you have a user who will be primarily responsible for collecting fonts 
from multiple projects for archiving, the administrator would enable the Collect Fonts for Output global 
permission for that user.  

Globally granted permissions override any permissions set by a user's role in the workgroup, as well as any 
custom workgroup permissions. 

 
Global permissions include font-based permissions as well as font attribute permissions.  

Global font-based permissions include the ability to: 

• Collect Fonts for Output 
• Add and Remove Fonts 
• Create and Delete Startup Sets 
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Font attributes are only stored within Universal Type Server and never applied to the source font file. Font 
attributes include all font licensing, keywords, styles, classifications, foundries and font family information. 
Administrators can grant or deny the ability to create, delete, and apply: 

• Licenses 
• Keywords 
• Font Attributes 

Workgroup Permissions 

Workgroup permissions are permissions that are restricted to a specific workgroup. Administrators can use 
this tab to grant or deny permissions for each user on a workgroup-by-workgroup basis.  

 
Permissions on the Workgroup tab are broken down for every workgroup to which the user belongs. Use the 
Show permissions for Workgroup drop-down menu to change which workgroup permissions are 
displayed. 

 All of the workgroup-based permissions can be set by the user's role in the workgroup, although custom 
permissions can be granted or denied. 

NOTE: If a permission is granted or denied in the Global permissions tab, it cannot be modified in the 
Workgroup tab. 

Use the Role in Workgroup drop-down menu to select the user's role for the workgroup displayed in the 
Show permissions for Workgroup menu above. 

A star (*) displayed next to the Role in Workgroup drop-down menu indicates that there have been custom 
workgroup permissions applied in the Workgroups tab. This is an easy way to see if the workgroup 
permissions are different than the default role permissions.  
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Font-based permissions can be granted or denied on a workgroup level. These include the ability to:  

• Collect Fonts for Output 
• Add and Remove Fonts 

All users can create their own sets within a workgroup. For sets to be visible to other users, the set must be 
shared within the workgroup. As an example, you may want to allow a user to create and delete shared sets, 
for a workgroup, but restrict their ability to modify the shared sets from other users. Shared set permissions 
include: 

• Create and Delete Shared Sets 
• Modify Shared Sets 
• Create and Delete Startup Sets 

Font attributes are only stored within Universal Type Server and never applied to the source font file. Font 
attributes include all font licensing , keywords, styles, classifications, foundries, and font family information. 
Administrators can grant or deny the ability to create, delete, and apply: 

• Licenses 
• Keywords 
• Font Attributes 
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Role Based Permissions 

The following permissions can be granted or denied to each user on a workgroup-by-workgroup basis. A 
user's role for each workgroup is set in the Workgroup permissions tab of the Users and Workgroups 
Administration web interface. 

Role-based permissions can be overridden, allowing the administrator to grant or deny permissions globally 
for a user, or on workgroup-by-workgroup basis for each user. 

Each permission has a three-state check box that switches between the role permission and whether the 
permission is custom granted or denied. If a permission is granted globally, it cannot be modified in the 
Workgroup tab. 

 

Add and Remove Fonts 

This permission allows the user to add font to and remove fonts from a workgroup. This is an important 
responsibility, because if a font is removed from a workgroup, and if it doesn't belong to any other 
workgroup, it is immediately removed from the Type Server. Enable this permission for users who are aware 
of this responsibility. 

Collect Fonts for Output 

This permission allows users to export fonts from the Type Server to a location outside of the server. Users 
may need to do this when sending a project from one company location to another.  

NOTE: It's important to note that fonts are individual pieces of software, and each font has specific font 
licensing requirements. Only collect and provide fonts to others whom you know have purchased the 
appropriate font licenses.  
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Create / Delete Shared Sets 

All users can create and modify their own sets in all workgroups for which they are a member. The sets are 
associated with each username and are therefore available only to that user.  

To allow the user to share a sets with the entire workgroup enable the Create / Delete Shared Sets 
permission. This can be helpful when users are creating a group of fonts to be used with a project. When the 
user finalizes the set and wants to bring others onto the project they share the set with the entire workgroup. 
So, in general, reserve this permission for project leaders. 

Enabling this permission also allows the user to unshare any set that they have shared, making it 
unavailable to others in the workgroup. The owner can also delete any sets that they have shared.  

Modify Shared Sets 

Enabling the Modify Shared Sets permission allows the user to add and remove fonts from all shared sets, 
as well as rename any shared set. The user can modify any shared set, including those created by other 
users.  

Create and Delete Startup Sets 

Enabling this permission allows users to make any set permanently active for all users of the workgroup. 
Fonts in startup sets cannot be overridden or deactivated by client users. This is handy to activate a 
standard set of corporate fonts for all users in a workgroup. 

The only way to deactivate or override fonts in startup sets is to remove the startup status of the set. Only 
users who have this permission are to disable a startup set. Removing the startup set status allows all users 
of the workgroup to deactivate and override fonts in the set. 

Font attribute options 

Font attributes are only stored within Universal Type Server and is never applied to the source font file. Font 
attributes include all font licensing, keywords, styles, classifications, foundries and font family information. 
Administrators can grant or deny the ability to create, delete and apply:  

• Licenses 
• Keywords 
• Font Attributes 

Font Attribute Options 

Controlling font attributes helps organize fonts. Font attributes includes font licenses, keywords, styles, 
classifications, foundries, and family information. Font attributes are stored only within Universal Type 
Server and in no way affects your original font files, so attributes are helpful for organizing and finding files. 
For example, keywords can be added to all fonts used for a project, client or print job. Fonts can later be 
found using this information. 

Administrators can set these permissions using three methods: 

• Set by the user role 
• Custom granted or denied in a user's Global permissions 
• Custom granted or denied in a user's Workgroup permissions 

All permissions can be set so that the user can create and delete attributes, or merely apply that item to 
fonts. For example, you might have one person who creates your list of keywords, yet everyone might have 
the ability to apply keywords to fonts. 

Styles, Classifications, Foundries, and Families - Enable this permission for users who need to modify 
Styles, Classifications, Foundries and Families. Typically these users create fonts or are those who 
absolutely know which foundry fonts came from. Enabling this permission also allows users to change how 
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the Type Client displays font family information. For example, if you believe that a font would better belong in 
another family group, you can drag that font file to another family.  

Licenses - Enabling a user to create and delete licenses allows that user to access the Licenses dialog box 
in the Type Client. Font licenses can be applied to specific fonts in the database so that you can track your 
font usage and compliance. For example, if you purchase 20 licenses of a font foundry's library, you can 
create a 20 user license and then apply it to all of the fonts that are part of that font library. 

 Keywords - Keywords are a good way to track fonts. You can create a keywording strategy that helps you 
track which fonts are used for specific projects or clients. As with the example used above, you may only 
have a few users who can create and delete keywords, but many users who are able to apply them to fonts. 

The System Administrator Super-user 

There is only one System Administrator Super-user account per Universal Type Server installation. The 
Super-user can perform any administrative task from the Server Administration and Users and Workgroups 
Administration web interfaces as well as any task in the Universal Type Client.  

Most importantly, the Super-user is the only user account that is able to assign or remove the Full 
Administrator setting, and cannot be deleted from the server. 

Typically, the only time the Super-user account is used is during the initial configuration of the Type Server, 
and when you need to add or remove users with the Full Administrator setting.  

The Super-user username is always set to "administrator" with the default password "password". For 
optimal security, change your default super-user password as soon as possible after installation.  

WARNING: Do not lose the super-user password! This is the only username and password that cannot 
be reset or recovered. If you do lose your Super-user password, please contact Extensis technical support 
for assistance.  

Changing the Administrator Account Password 

After installing the server, for security reasons, it is very important to change the password for the System 
Administrator Super-user account. This account has access to all of the functions of the Universal Type 
Server and can delete and change all users and workgroups. It is important to keep this account login 
secure. 

Until other users are created, the Super-user account is the only account with access to the Users and 
Workgroups Administration interface.   

To change the administrator password: 

1. Open the Users and Workgroups Administration web interface.  
The default administrator login credentials are: 
username: administrator 
password: password 

2. In the Workgroups pane, click the All Users link. 
3. In the Users pane, select the Administrator user account. 
4. In the Details pane, select the Account tab and enter a new password in the Password field. 
5. Click Save. 

WARNING: Do not lose your System Administrator Super-user password! This is the most important 
password for your entire system and cannot be easily retrieved or reset.  
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User Worksheet 

Account Data 
Account Name:   
Full Name: ______________________________________ 
Email Address:   
Password:   

  

User Workgroups 
Workgroup Role in Workgroup 

___________________________ _________________________ 
    
    
    
    

  

Account Settings 
Is Full Administrator   
Change Password _______ 
Activate Fonts Across Workgroups   
Time between server syncs   
Font Replication Mode 

All   
On Demand   

On Demand Local Cache   
Has Personal Workgroup 

Server Based   
Client Based   

  

Global Permissions 

Collect Fonts for Output     
Add and Remove Fonts     
  Create and Delete Apply to Fonts 

Licenses     
Keywords     

Styles, Classifications, 
Foundries, and Families 
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Deleting Users 

When a user no longer needs access to served fonts, you can safely delete their user account from 
Universal Type Server.  

If you think that the user will need access in the future, you may wish to leave their account active, yet 
remove them from all workgroups. Removing a user from all workgroups prevents them from getting any 
fonts from the server, yet the user will still be able to use any fonts in their personal workgroup. Though, it is 
important to note that the user still consumes a license.  

If you need an additional user license for others to access Type Server, you can force the user to 
disconnect, and remove the user account. To force user disconnection, click the Users link in the Server 
Administration web interface. For complete details, see Server Administration User Guide and web help. 

To remove a user account: 

1. Open the Users and Workgroups Administration web interface. 
2. Select the All Users workgroup. 
3. Select the user account name and click the Remove (-) button in the Users pane.  
4. Click OK to confirm the account removal. 

Searching Users 

If you have a large number of Type Server users, to quickly locate a specific user you can use any user data 
to search for the user.  

To search for a user: 

1. Open the Users and Workgroups Administration web interface. 
2. From the Workgroups pane, select a workgroup. 
3. At the bottom of the Users pane, enter any part of a username, email address, or notes for the 

user. For example, enter "Joe" to find all users that have the username, part of an email address 
or notes that contain the text "Joe." The Users pane automatically updates to display only users 
who contain that data.  



Universal Type Server Users and Workgroups Administration Guide 

39 

Managing System Fonts with a System Font Policy 
System font folders locations on a user's machine where fonts are automatically activated by the operating 
system. Fonts in system font folders are automatically active and available to all applications. For security 
purposes, and to prevent users from installing and utilizing unapproved fonts, you way want to restrict which 
fonts are placed into these folders.  

The System Font Policy feature allows Universal Type Server administrators to create a list of system fonts 
that are allowed in a user's system font folder.  

With a system font policy implemented, the Universal Type Client periodically compares the fonts in each 
user’s system fonts folder with those on the approved list. When an unapproved font is located, it is 
automatically removed and no longer available to the user.  

To help get you started, each system font list is automatically populated with fonts that are known as 
required system fonts. These fonts are considered essential for each client operating system to function 
properly. 

Universal Type Server can only modify and remove system fonts from locations where the client user has 
permission to delete fonts. For example, in Mac OS X environments, many client users are not able to read 
or right from the /System/Library/Fonts folder. So, if the user does not have the ability to modify the 
directory, Universal Type Server ignores it.  

System font policies cover both Mac and Windows clients. So if you have a user who utilizes both Mac and 
PC clients, the appropriate font policy is applied depending upon the current OS in use.  

Creating a System Font Policy 

System font policies are created on an operating system basis. An approved font list can be created for both 
Microsoft Windows and Mac OS X.  

Known required fonts are automatically added to all system font policies for the each operating system and 
are listed in gray. As a safety precaution, required fonts cannot be removed. Each font list includes fonts for 
all supported operating system versions (Windows XP, Vista, Mac OS X v10.4, v10.5, etc.)  

A number of commonly required fonts are also pre-populated in the list. These fonts are listed in black and 
may be removed from the list if desired.  

You can implement a system font policy with the default lists, or you can modify the list to add or remove 
fonts. Keep in mind that additional fonts may be required for applications to function properly in your 
environment.  

NOTE: Some design applications, such as Adobe Illustrator on Mac OS X, activate fonts from non-system 
font locations. These fonts are not affected by system font policies. 

Fonts are added to the system font policy by font file name, so when developing a list of allowed fonts, it is 
important to record the name of the physical file, and not the PostScript name of the font. 

To add fonts to a system font policy: 

1. Open the Users and Workgroups web interface. 
2. From the Window menu, choose System Font Policy. 
3. Click the Add (+) button beneath the list that you want to add a font.  
4. Type the font's file name into the text box and press Enter to add the font to the list 

The font is immediately added to the System Font Policy font list. This list is transferred to Type Client users 
who are restricted to the system font policy when they synchronize with the Type Server. The Type Client 
scans system font locations periodically to check for unauthorized fonts.  

NOTE: Adding a font from the System Font Policy does not automatically add that font to a client user's 
system. It only indicates that the font is allowed in the user's system fonts folder. 
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To remove fonts from a system font policy: 

1. Open the Users and Workgroups web interface. 
2. From the Window menu, choose System Font Policy. 
3. Select a font name from either list. 
4. Click the Remove (-) button beneath the list from which you want to remove the font.  

Any fonts removed from the list are immediately removed from System Font Policy font list. The list is 
transferred to Type Client users who are restricted to the system font policy the next time they synchronize 
with the server.  

Enabling a system font policy 

After creating a font list for the system font policy, administrators can enforce this list for selected Universal 
Type Client users. 

The font policy is operating system dependent, so users are restricted to the allowed fonts depending upon 
the current operating system in use. 

To enable a font policy for users: 

1. Open the Users and Workgroups web interface. 
2. From the Workgroups pane, select a workgroup. 
3. In the Users pane, select one or more users that you want to enable a font policy. 
4. In the Details pane, click the Settings tab. 
5. Enable the Enforce System Font Policy option and click Save. 

This System Font Policy font list is transferred to selected users the next time the user synchronizes with the 
Type Server. The Type Client then scans system font locations periodically to check for unauthorized fonts. 
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Font Compliance Reporting 
Universal Type Server includes the ability to generate and export reports to help you determine if you are 
complying with your font licenses. The font compliance feature only allows you to track your licensing 
compliance and does not restrict access to non-complaint fonts. 

To help you understand how the font licensing compliance, let’s look at the following typical example of how 
to use licenses and the font compliance report in your environment. 

Say you are starting up your own design shop and need a good group of licensed fonts for your designers to 
create projects that will bring you fame and fortune. You know that fonts are valuable, and you want to be 
sure that you have purchased enough licenses for your requirements. So, you purchase a 10-user license of 
a sizable font library. Using the Universal Type Client, these fonts are added to a Type Server workgroup as 
a set. A font license is then created and the Number of Seats field is set to 10. This license is then applied to 
all fonts in the set. 

When you run the font compliance report, Universal Type Server compares the number of seats allowed to 
the total number of unique users who have access to the workgroup. If more users have access than 
licenses available, the fonts are listed as “non-compliant.” You can now either remove users from the 
workgroup or purchase more font licenses to become compliant. 

Entering Font Licenses 

For the font compliance report to be accurate, font licenses must first be entered and applied to fonts using 
the Universal Type Client. 

Depending upon the number of licenses that you have purchased, this can be a time consuming process. 
You may want to distribute the entry of licenses to multiple client users. To do so, first enable permission for 
select users to add and remove licenses as well as apply those licenses to fonts. 

NOTE: For complete details about creating and applying font licenses, see the Universal Type Client user 
guide and online help. 
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Displaying the font compliance report 

The font license compliance report displays fonts that are licensed as well as those that are considered to be 
“non-compliant.” Non-compliant fonts are available to more users than applied font licenses allow. 

To display the font compliance report: 

1. Open the Users and Workgroups web interface. 
2. From the Window menu, choose Compliance. 

By default, the compliance report displays all licensed fonts, as well as all of the fonts that are considered 
non-compliant. 

The report columns display the following information: 

• Name: The PostScript name of the font. This may not directly correspond to a single file if the 
font is contained within a suitcase that contains many faces. 

• Workgroup: The workgroups that contain the font. Each workgroup is displayed on a separate 
row. 

• Added by: who uploaded the font to the server. 
• Date Added: when the font was uploaded. 
• User Count: the number of users in the workgroup who have access to the font. 
• Unique Users: the total number of users across all workgroups who have access to the font. 
• License Count: the number of seats entered in the font license. 
• Unused Licenses: The difference between the License Count and number of Unique Users. 

When you select a font, metadata about the selected font, including PostScript name, Type, version, etc. is 
displayed at the bottom of the report. This information can be helpful when determining the difference 
between two similarly named fonts in the report.  

To refine the font compliance report, from the Options menu: 

• Choose Show > All Licensed Fonts to enable or disable the display of every licensed font 
stored in Universal Type Server. 

• Choose Show > Non-Compliant Fonts to enable or disable the display of fonts that are 
considered non-compliant. 

The font compliance report is generated automatically when you open the Users and Workgroups 
Administration web interface. If you have changed user access to workgroups during your session, or if a 
user has modified font licenses, you may need to regenerate this report. 

To regenerate the font compliance report: 

• Click the Regenerate button in the upper right of the report. 

Displaying applied font licenses 

All font license manipulation including license creation, modification and application to fonts is performed in 
the Universal Type Client. 

As a convenience, font licenses that are applied to fonts can also be viewed from within the font compliance 
report. Select a font name in the report and click the View Licenses button at the bottom of the report to 
display license details for the selected font. When you are done reviewing the license, click the close button 
to return to the report. 

NOTE: for more information about the creation and application of font licenses, see the Universal Type 
Client user guide and help system. 
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Exporting a compliance report 

The font compliance report can be exported to a tab-delimited text file (UTF8) that can be imported by any 
spreadsheet application. The exported information includes all fonts currently displayed in the font 
compliance report. 

To export a compliance report: 

1. From the Options menu choose Export. 
2. Name the export file, navigate to a location to save the file and click OK (Win) or Choose (Mac). 
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Directory Integration 
Directory integration allows network administrators to automatically synchronize users from an LDAP service 
(Active Directory on Windows or Open Directory on Mac OS X) with Universal Type Server workgroups. This 
offers many benefits for both server administrators and client users. With directory integration, server 
administrators can:  

• Automate and secure user login: Automatically add or remove users from Universal Type 
Server when directory service accounts are added or deleted.  

• Simplify user management: Create workgroups in Universal Type Server that map to already 
existing distribution groups and organizational units, and give users font access according to 
their group membership. 

• Provide user authentication with Kerberos: The same username and password used for 
system access can be used for single sign-on access to Universal Type Server.  

Configuring Directory Integration and Synchronization 

The process of configuring a directory service includes the following steps: 

1. Verify directory integration system requirements. 
2. If desired, configure Single sign-on with Kerberos authentication. 
3. Bind Universal Type Server to your directory service. 
4. Query the directory service for sources. 
5. Map directory service sources to Universal Type Server workgroups. 
6. Synchronize with the directory service. 

Directory integration system requirements 

Directory integration is supported for a variety of LDAP implementations, including:  

• Active Directory on Windows Server 2003 SP2  
• Active Directory on Windows Server 2008 SP2 
• Open Directory on Mac OS X Server 10.5.7 or 10.6 

Server Hardware requirements vary with each server type. See the following links for more information 
about required server hardware.  

• Windows Server 2003 http://technet.microsoft.com/en-us/library/cc739022.aspx 
• Windows Server 2008 http://technet.microsoft.com/en-us/library/cc771188.aspx  
• Mac OS X http://www.apple.com/server/macosx/technology/opendirectory.html 

Your LDAP service must be installed and appropriately configured before binding with Universal Type 
Server. 

Configuring Single Sign-on with Kerberos Authentication 

Directory integration with Universal Type Server supports the optional use of Kerberos authentication, also 
known as Kerberos single sign-on. See the following information for complete details and benefits of using 
Kerberos authentication with Universal Type Server. 

IMPORTANT: Configuring your server for Kerberos authentication is an optional step, but must be 
configured before connecting Universal Type Server to your LDAP service. If you do not want to configure 

http://technet.microsoft.com/en-us/library/cc739022.aspx�
http://technet.microsoft.com/en-us/library/cc771188.aspx�
http://www.apple.com/server/macosx/technology/opendirectory.html�
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Kerberos, directory service users are still be able to log in using their domain username and type server 
password. When Kerberos is not enabled, Type Server passwords are initially set to each user's domain 
username. The default password can be changed at any time by the end user.  

NOTE: Because Kerberos relies on communication between all parts of the system (the directory service, 
Universal Type Server, and Universal Type Client), some special configuration is required. 

What is Kerberos? 

Kerberos is a secure protocol for user authentication developed at MIT and supported by both Microsoft 
Active Directory and Apple Open Directory. Kerberos is different from regular password authentication. 
Password authentication generally involves a client sending a password to the service, which the service 
then compares against an encrypted value stored in a database or file. With Kerberos, the client never 
sends a password. Instead, it requests a data structure called a ticket which grants it access to the service; it 
sends this ticket (instead of a password) and the service verifies that the ticket is valid (which also proves 
the identity of the client user to the service). 

What is single sign-on? 

Single sign-on is a method of proving a user's identity once and using that proof to connect to multiple 
services. For instance, a Windows user at log-in time enters their network password to authenticate the local 
machine; for the remainder of that login session, the user does not have to enter their password again to 
connect to services which support single-sign-on. Both Windows and Mac OS X client machines have 
support for Kerberos single-sign-on where the user's login obtains a special Kerberos ticket. This ticket can 
be used to request access to other services without requiring the user to enter their password again. The 
Universal Type Client supports the use of these tickets, avoiding the need for the users to enter a password. 
All ticket-granting is typically done by the operating system and is transparent to the end user. 

Ensuring your Windows or Mac client machine binds to a Kerberos realm at login (either through Active 
Directory or Open Directory) is covered in the administration guides for those operating systems and 
services. 

Why use Kerberos single-sign-on with Universal Type Server? 

There are two main reasons to configure Universal Type Server for use with Kerberos: security and 
convenience. 

Kerberos is a more secure authentication mechanism than password authentication. With Kerberos, the 
user's password is never sent across the network, where it might be observed in transit and used for exploits 
against your network services and data. Also, Kerberos permits the user's password to only be stored in one 
secure place, by Active Directory or Open Directory. Passwords for directory service users are never visible 
or stored by Universal Type Server or Client. 

If your client machines are configured to establish their users' Kerberos identities at log-in (which is the 
default for Windows clients in an Active Directory domain), Kerberos provides the convenience of single-
sign-on. In this configuration, a user who has been mapped from your directory service to Universal Type 
Server never needs to enter a password to connect to Universal Type Server because they've already 
proven their identity at system log-in. Even if you don't configure all of your clients for single-sign-on, 
Kerberos is a convenient way to reduce the number of passwords a user has for different services, since in 
this case their network password is used. 
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Configuring Universal Type Server for Kerberos 

In order for a service to authenticate users with Kerberos, it must be “kerberized” - it must know how to 
handle Kerberos information and it also must have its own identity established with the directory service. 
Several of these steps require administrative access to your Active Directory or Open Directory server, as 
well as administrative access to the machine where your Type Server is installed. 

The steps you'll need to take vary by the type of directory service to which you are connecting.  

Basically, you need to do the following: 

1. Create a service principal for your Type Server in your Directory Service. 
2. Export a keytab file and store it on the machine running Universal Type Server. 
3. Restart Universal Type Server. 

For complete details, see the Active Directory and Open Directory single sign-on configuration topics.  

NOTE: Universal Type Server must be installed before configuring Kerberos. You will also need to know the 
IP address of the machine running your Type Server. 

NOTE: After configuring your Type Server for Kerberos, to make single sign-on totally transparent to your 
users, you may wish to deploy a configuration file to Universal Type Client machines. This file provides 
server location and port information to the Type Client speeding up the login process.  

Configuring Active Directory single sign-on 

Universal Type Server can be configured to utilize Active Directory services with the following steps. Even 
though Active Directory is Windows-based, both Mac-based or Windows-based Universal Type Servers can 
be connected to an Active Directory service. Universal Type Clients can also be either Mac or Windows-
based. 

Creating a Service Account 

In the Active Directory User and Group administration interface, create a new user to represent Universal 
Type Server. This is not an account that is accessible by Type Client users, nor does it have to have specific 
rights on your network. It is only used to connect Universal Type Server to Active Directory. 

The account must be named universaltype and given a non-expiring password. 
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Creating a Keytab file for Active Directory 

After creating a new user, create a Kerberos keytab file for Universal Type Server. The keytab is a specially 
encrypted file created by your directory service. It permits Universal Type Server to perform Kerberos 
authentication when it receives tickets, without requiring anyone to enter (or store) the passwords. 

The ktpass command is used on your Active Directory server to generate a keytab file for Universal Type 
Server.  

To create a keytab file on your Active Directory server: 

1. Open a Command Prompt by choosing Start > Run and entering CMD, or by choosing Start > 
Accessories > Command Prompt. 

2. Enter the following command. Replace the parameters in the chart with your own. 

ktpass -out [desired-keytab-file] -princ [SPN@REALM] -mapUser [service-user] -
pass [service-user-password] -pType KRB5_NT_PRINCIPAL -crypto DES-CBC-MD5 
+desonly 

parameter details 
[desired-keytab-file] The desired name and location of your 

keytab file. The file must be 
named:universaltype.keytab. It can 
be placed any write-able location for now. 

[SPN@REALM] Your desired service principal name and 
REALM. this should be in the format 
universaltype/[ip address of 
server]@[REALM of server in 
ALL CAPS] The ktpass command creates 
a service principal using these settings. 

[service-user] The service user account name that you 
created for your Type Server. 

[service-user-password] The password associated with the service 
account name for your Type Server. 

For example, with the following parameters: 

• Desired filename and output file location: c:\temp\universaltype.keytab 
• Desired SPN@REALM: universaltype/10.1.6.20@ACME.COM  
• Type Server's user account name: universaltype 
• User password: Fonts4Us 

The command would look like this: 
ktpass -out c:\temp\universaltype.keytab -princ 
universaltype/10.1.6.20@ACME.COM -mapUser universaltype -pass Fonts4Us -pType 
KRB5_NT_PRINCIPAL -crypto DES-CBC-MD5 +desonly 

NOTE: the +desonly parameter indicates that DES encryption types must be used.  

If entered correctly the output of this command will contain the following lines: 
... 

Key created. 

Output keytab to [output location] 

... 
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After running the command, you should have a universaltype.keytab file in the output location 
specified.  

NOTE: The file must be named universaltype.keytab. 

3. Copy the universaltype.keytab file to the following location on your Universal Type Server 
machine: 

 For a Windows-based Universal Type Server: 
C:\Program Files\Extensis\Universal Type Server\data\sso\universaltype.keytab 

For a Mac OS X-based Universal Type Server: 
/Applications/Extensis/Universal Type Server/data/sso/universaltype.keytab 

Restart Universal Type Server, and your Type Server is now "kerberized." When you bind Universal Type 
Server to your Active Directory service, you can enable (and optionally require) Kerberos. 

Configuring Open Directory single sign-on 

Universal Type Server can be configured to utilize Open Directory services with the following steps. Even 
though Open Directory is Mac OS X-based, both Mac-based or Windows-based Universal Type Servers can 
be connected to an Open Directory service. Universal Type Clients can also be either Mac or Windows-
based. 

Creating a Service Principal for Open Directory 

Log into the Mac OS X Server machine where Open Directory is running and launch the Terminal 
application. You must be a user with administrative privileges, and you must also know the principal name 
and password of an Open Directory administrator account (this may be different than the login account on 
the Open Directory server machine). 

A service principal for Universal Type Server must be created in the Open Directory server's Kerberos 
database. This is done using the kadmin.local command-line tool.  

The Type Server service principal must be named universaltype in the form:universaltype/[IP 
Address]@[REALM].  

For instance, if the IP address of the machine where Type Server is installed is 10.1.6.22 on the local 
network, and your Open Directory realm is ACME.WIDGETS.COM, then the service principal name will be 
universaltype/10.1.6.22@ACME.WIDGETS.COM. 

To add the service principal: 

1. Login to your open directory server as a user with administrative privileges.  
2. Open the Terminal from Applications > Utilities > Terminal. 
3. Enter the following command. Replace [admin-principal] with your directory administrator 

account, and [service-principal] with your specific service principal as described above.  

$ sudo kadmin.local -p [admin-principal] -q “addprinc -randkey [service-
principal]” 

4. Enter the password for your directory administrator account. 

For example, if your Type Server installation is at 10.1.6.22, your Open Directory realm is 
ACME.WIDGETS.COM, and your directory administrator account is named diradmin, you would the 
following commands (typical output is also shown): 
$ sudo kadmin.local -p diradmin -q “addprinc -randkey 
universaltype/10.1.6.22@ACME.WIDGETS.COM” 



Universal Type Server Users and Workgroups Administration Guide 

49 

Password: 

Authenticating as principal diradmin with password. 

Password for diradmin@ACME.WIDGETS.COM: 

WARNING: no policy specified for universaltype/10.1.6.22@ACME.WIDGETS.COM; 
defaulting to no policy 

Principal “universaltype/10.1.6.22@ACME.WIDGETS.COM” created. 

Creating a Keytab file for Open Directory 

Once a service principal is created, you will need to create a Kerberos keytab file for Universal Type Server. 
The keytab is a specially encrypted file created by your directory service. It permits Universal Type Server to 
perform Kerberos authentication when it receives tickets, without requiring anyone to enter (or store) the 
passwords. 

To export a keytab file for Universal Type Server with Open Directory, use the kadmin.local command 
with a ktadd query argument.  

To create a keytab on your Open Directory server: 

1. Open the Terminal from Applications > Utilities > Terminal.  
2. Enter the following command. Replace the parameters in the chart with your own, though the 

keytab file must be named universaltype.keytab 

$ sudo kadmin.local -p [admin-principal] -q "ktadd -k [desired-keytab-file] 
universaltype/[IP address]@[realm]" 

parameter details 
[admin-principal] The Open Directory Administrator account. 
[desired-keytab-file] The desired name and location of your 

keytab file. The file must be 
nameduniversaltype.keytab. It can 
be placed any write-able location for now. 

[IP address] The IP Address of your Universal Type 
Server. 

[realm] Your Open Directory realm. 

For example, with the following parameters: 

• Open Directory Administrator account name: diradmin 
• Desired filename and output file location:/Users/Shared/universaltype.keytab 
• IP Address: 10.1.6.22 
• Realm: ACME.WIDGETS.COM 

The command would look like:  
$ sudo kadmin.local -p diradmin -q "ktadd -k /Users/Shared/universaltype.keytab 
universaltype/10.1.6.22@ACME.WIDGETS.COM" 

3. Authenticate with your Open Directory Administrator password. 
4. Use the chmod command to modify your keytab file so that it can be copied to your Universal 

Type Server machine. Replace [desired-keytab-file] with the settings you used in the 
previous command. 

$ sudo chmod a+r [desired-keytab-file] 
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For example: 
$ sudo chmod a+r /Users/Shared/universaltype.keytab 

5. Copy the universaltype.keytab file to the following location on your Universal Type Server 
machine: 

 For a Windows-based Universal Type Server: 
C:\Program Files\Extensis\Universal Type Server\data\sso\universaltype.keytab 

For a Mac OS X-based Universal Type Server: 
/Applications/Extensis/Universal Type Server/data/sso/universaltype.keytab 

Restart Universal Type Server, and your Type Server is now "kerberized." When you bind Universal Type 
Server to your Open Directory service, you can enable (and optionally require) Kerberos. 

Deploying a configuration file 

To enable Universal Type Client users to connect quickly with Universal Type Server, administrators can 
create and deploy a configuration file that contains connection information for the Type Client. When this file 
is placed on each Universal Type Client machine, the login dialog is pre-filled with the correct server address 
and port. When used in conjunction with Kerberos authentication, this can provide a seamless login (single 
sign-on) to Universal Type Server. 

The configuration file format follows the basic format of parameter=value. The following parameters can 
be set: 

Parameter Description 
server.address The Universal Type Server address,This can either be a DNS name or an IP 

address. If using this parameter, a server.port parameter must also be 
specified. 

server.port The port number of Universal Type Server. If using this parameter, a 
server.address parameter must also be specified. 

server.bonjour The Bonjour name of the server, if one exists. If this parameter is declared, it 
takes precedence over any server.address and server.port parameters. 

For example, if your Universal Type Server is at the IP Address 10.1.2.34 using the default port, you 
configuration file would contain the following parameters: 
server.address=10.1.2.34 
server.port=8080 

If you choose a Bonjour name for your server instead, the file could only contain a single parameter. For 
example, if you gave your Type Server the Bonjour name "FontServer" the configuration file would only 
contain the following parameter: 
server.bonjour=FontServer 

To allow the Universal Type Client to recognize the configuration file, it must be saved as a UTF-8 text file 
for Mac clients or ANSI text file for Windows clients. The file must be named 
com.extensis.UniversalTypeClient.conf and placed in the following location on the client 
machines: 

Macintosh:  
/Library/Preferences/com.extensis.UniversalTypeClient.conf 

Windows: 
C:\Program Files\Extensis\Universal Type 
Client\com.extensis.UniversalTypeClient.conf 
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Binding Universal Type Server to a directory service 

Before binding to a directory service, at least one workgroup must exist in Universal Type Server. This is 
because LDAP users, distribution groups, organizational units and so forth are mapped directly to Type 
Server workgroups. If you have not already created a workgroup, Type Server automatically creates one for 
you. 

To bind to a directory service: 

1. Open the Users and Workgroups web interface.  
2. From the Window menu, choose Directory Service. 
3. In the Configure Directory Service dialog box, enter the connection settings of your directory 

service. 

Hostname: The IP address or DNS name of your directory service. 

Port: Enter the LDAP connection port, the default port is 389. If SSL is required, enable the Use SSL option 
and update the port accordingly (default SSL port is 636). 

Type: Choose your directory service type. Active Directory (Microsoft Windows) or Open Directory (Mac OS 
X).  

LDAP bind username: A username that has permission to query the directory service. How you enter the 
username varies by the type of directory service you are using.  

For Active Directory, enter the username as either: 

• domain\user - e.g. mycompany\jsmith 
• user@realm - e.g. jsmith@mycompany.com 
• The fully qualified LDAP distinguished name (DN). e.g. 

uid=jsmith,cn=users,dc=MARR,dc=MYCOMPANY,dc=COM 

For Open Directory enter the username as either: 

• The domain username only. This method requires that anonymous directory authentication be 
enabled. This is the default setting for Open Directory. e.g. jsmith 

• The fully qualified LDAP distinguished name (DN). e.g. 
uid=jsmith,cn=users,dc=MARR,dc=MYCOMPANY,dc=COM 

Password: password for the above username. 

4. Choose the following options for how your server will handle the removal of users from the 
directory service as well as synchronization settings. 

• Delete UTS users when removed from directory service. This keeps your Type Server Users 
in sync with your directory service users. When disabled, if a user is removed from the directory 
service, that user retains their account on Universal Type Server. 

• Schedule user synchronization: Once a Day/Once an Hour/Once a week. When disabled, 
Universal Type Server only synchronizes with the directory service when you choose to force 
synchronization. 

• Cache credentials for updates. This setting retains the connection settings for future directory 
service synchronization. Credentials cached for automatic updates are encrypted and stored in 
the Universal Type Server database for future use. 

5. Client authentication can be configured to use either LDAP Bind or Kerberos. 

• Use LDAP Bind - this option enables LDAP-bind style authentication for Type Clients. If you are 
unsure which type of client authentication to use, use this option.  

• Enable Kerberos for Single Sign-on - enables Kerberos authentication. Your server must be 
"kerberized" or configured to support Kerberos tickets for this option to be available.  
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6. Disable UTS passwords for directory users - this option restricts user logins to those 
authenticated through Kerberos or LDAP Bind. NOTE: using this option prevents users from 
connecting with version 1.0 of the Universal Type Client, since this option was not supported in 
earlier versions.  

7. Click Save to bind your directory service to Universal Type Server.  

After successfully binding, the Directory Service window is displayed where you query the LDAP server and 
map LDAP resources to Type Server workgroups. 

Query the Directory Service 

The Service Browser pane of the Directory Service window provides access to query your directory service 
to locate users, distribution groups, organizational units (OUs), security groups and so forth. 

The directory listings in the Query Results window are used to create mappings between the directory 
service and Universal Type Server workgroups. 

The directory service query uses standard LDAP query syntax. If you are unfamiliar with this query syntax, 
we have provided a number of common queries from which you can choose. If you would like to know more 
about LDAP queries please read “The String Representation of LDAP Search Filters" at 
http://www.ietf.org/rfc/rfc2254.txt 

The Search Base 

A query is basically the combination of a search base and query filter. The search base can be used to 
restrict your search to just one part of the LDAP directory. This can be especially handy if your directory 
service is configured to include discrete branches of users and groups by location or department. 

Your company may have already created organizational units (OU) or containers in your directory service. 
Organization units are like folders in LDAP and can contain users, groups, and/or other OUs. Creating a 
search base that is limited to an OU is a quick way to narrow your search. 

For example, if the default (root) search base for your LDAP tree is DC=acme,DC=com, but you only want to 
search for items below an organizational unit(OU) named "NYC", you would enter that OU as your search 
base. For example: OU=NYC,DC=acme,DC=com. This search base only returns results within the “NYC” 
organizational unit. 

The Query Filter 

The query filter helps you locate users, groups and organizational units (OUs) from within the search base. 

The Service Browser contains a number of pre-built query filters for your convenience from a drop-down 
menu. 

In Active Directory, the default queries are:  

• Entire Tree Under Search Base – displays the highest level of the LDAP tree within the search 
base. Use this if you want to drill down to a specific location manually. 

• Distribution Groups – displays all distribution groups within the search base. 
• Security Groups – displays all security groups within the search base. 
• Users – lists all users; excludes all groups. 
• Name - use this query filter to locate users by name. This filter includes the options to search if a 

name contains, starts with or equals the entered text. 

http://www.ietf.org/rfc/rfc2254.txt�
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In Open Directory the default queries are: 

• Entire Tree Under Search Base – displays the highest level of the LDAP tree within the search 
base. Use this if you want to drill down to a specific location manually. 

• Groups – displays all groups within the search base. 
• Users – lists all users; excludes all groups. 
• cn - use this query filter to locate users by name, the cn attribute. This filter includes the options 

to search if a name contains, starts with or equals the entered text. 

Mapping Directory Service resources to Universal Type Server workgroups 

Users, groups and organizational units (OUs) in a directory service are mapped directly to Universal Type 
Server workgroups. You can map any combination of users, groups and OUs to a Type Server workgroup. 

Directory service search results are mapped to workgroups through the Mappings Pane using your query 
results. 

To create a directory service mapping: 

1. Open the Users and Workgroups web interface. 
2. From the Window menu choose Directory Service. 
3. Use the Search Browser pane to query the directory service.  
4. In the Mappings Pane of Directory Service window, choose a workgroup from the Target Font 

Workgroup drop down menu. 
5. Drag a user, group or OU from the Query Results of the Search Browser into the Mappings 

Pane, or click the Add button (>>). 
6. Choose a role for mapped users from the Role for Import drop down menu. This sets initial role 

for all of the users in a mapped group or OU. The default role can be changed for any user after 
their Type Server account is created by the directory service. 

7. Click Save Mapping. 

All mapping changes are applied the next time the Universal Type Server synchronizes with the directory 
service. If you want to apply the changes immediately, you can force synchronization by using the 
Synchronize Now command.  

Synchronizing with the directory service 

Typically the Universal Type Sever synchronizes with your directory service based on a set schedule 
defined when you bind to the directory service. 

If you want to apply new or changed mappings, or add new users to Type Server immediately, you may 
want to force the synchronization. 

To force directory service synchronization: 

1. Open the Users and Workgroups web interface. 
2. From the Window menu choose Directory Service. 
3. From the Options menu, choose Synchronize Now. 

NOTE: When new users are added during synchronization, if Kerberos single-sign on is not enabled, the 
user's default type server password is set to their username.  

If you want to update how frequently Universal Type Server synchronizes with the directory service, update 
the Directory Service settings. 
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To update the Directory Service synchronization settings: 

1. Open the Users and Workgroups web interface. 
2. From the Window menu choose Directory Service. 
3. From the Options menu, choose Edit Settings. 
4. In the Configure Directory Service dialog box, enable or disable the Schedule User 

Synchronization option and choose a synchronization interval from the drop-down menu. 
5. Click Save to apply the new settings. 

NOTE: If desired, you can also automate synchronization with the directory service by writing a script that 
launches the directorySynchronize command. See the Server Administration Guide for more 
information.  

Directory Integration and user passwords 

It's important to understand how your directory integration configuration affects how users connect with 
Universal Type Server.  

Default Universal Type Server installation 

When users are created in the Users and Workgroups Administration web interface without using directory 
integration, they are considered standard Type Server users. These users connect to Type Server using the 
username and password that was manually created for them.  

If given permission to do so, each user can change their password using the Server > Change Password 
command in Universal Type Client. 

Universal Type Server with Directory Integration 

Using directory integration, the process or creating users and usernames is simplified. When Kerberos 
single sign-on is not enabled, as directory service users are synchronized with Type Server, each user's 
default password is set to their username.  

NOTE: If a directory service user account name is identical to an already-existing Type Server user, they are 
promoted to a directory service user, but the Type Server password for this user is not changed. 

If given permission to do so, each user can change their password using the Server > Change Password 
command in Universal Type Client. This command updates only the user's Type Server password, and has 
no relation to the user's domain password. 

Universal Type Server with directory integration and Kerberos 

When Type Server is configured with Kerberos single sign-on authentication, the process for a user to login 
to Type Server is different. 

With Kerberos single sign-on enabled, directory service users can login to Type Server using only their 
username. Authentication is provided automatically in the background by Kerberos.  

NOTE: Older versions of the Universal Type Client do not support Kerberos authentication. With Kerberos is 
enabled, users are also able to login using older versions of the Universal Type Client, but must supply their 
standard Type Server password. Accordingly, the Disable UTS passwords for directory users option 
must be disabled, to allow any user (including older versions of the Type Client) to login with a standard 
Universal Type Server password. For a directory user, the default password is automatically set to their 
domain username.  
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If given permission to do so, users can change their default password with the Server > Change Password 
command in the Universal Type Client. This in no way affects the Kerberos authentication, or the user's 
domain password. Changing the password only affects user's Type Server login from older Type Clients that 
do not support Kerberos authentication.  

Universal Type Server with Directory Integration, Kerberos and a configuration file 

In addition to Kerberos, Universal Type Client machines can be configured to automatically locate the Type 
Server and appropriate port with a configuration file to facilitate single sign-on.  

With the configuration file placed in the appropriate location on the user's machine, and with the user 
logged-in to the directory service, when the Universal Type Core is started, the configuration file provides 
the server location and port, and the user is automatically logged-in to the server.  

Removing a directory service mapping entry 

Removing a directory service mapping entry removes only that mapping from the Universal Type Server. 
Universal Type Server is still bound to the directory service. Only the selected mapping entry is removed. 

To remove a mapping entry: 

1. Open the Users and Workgroups web interface. 
2. From the Window menu choose Directory Service. 
3. In the User/Workgroup Mapping pane, from the Target Font Workgroup drop-down menu choose 

the Type Server workgroup that contains the mapping entry to remove. 
4. In the Import Source column, select the mapping entry to remove and click Delete Source. 
5. Click Save Mapping to save your changes. 

All mapping changes are applied the next time the Universal Type Server synchronizes with the directory 
service. If you want to apply the changes immediately, you can force synchronization by using the 
Synchronize Now command.  

Any users who were added by this directory mapping are automatically converted into regular Universal 
Type Server users with the same settings and permissions, yet no longer linked to the directory service. For 
example, if a user changes his domain password, Type Server will not be permitted with this new password. 

Deleting a Directory Service Configuration 

You may want to delete a directory service configuration. As a convenience, when you disconnect Universal 
Type Server from a directory service, to maintain user connectivity and continuity, users who were added via 
the service are automatically converted into regular Type Server users. 

To delete a directory service configuration: 

1. Open the Users and Workgroups web interface. 
2. From the Window menu choose Directory Service. 
3. From the Options menu, choose Delete Service. 

When downgrading from a directory service implementation with Kerberos authentication enabled, users are 
converted to regular Type Server users. Since Universal Type Server doesn't retain Kerberos passwords 
from directory services, each user's Type Server password is now set to their username.  
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Excluding directory service users 

When mapping users from a directory service to a Universal Type Server workgroup, there may be some 
users in a directory service resource who you don't need access to the Type Server.  

As an administrator, you can still map the entire directory service OU, or other resource to a Type Server 
workgroup, and then exclude the selected users from that group.  

There are two ways in which you can exclude users. 

To exclude users from the Directory Service window: 

1. Map a directory service resource to workgoup.  
2. From the Mappings Pane, select the directory mapping. 
3. In the Search Browser pane, select the user to exclude from the directory mapping. 
4. Click the Exclude (/) button at the bottom of the Search Browser pane. The user is excluded 

from the directory service mapping, and is listed in below the directory mapping in the Mappings 
Pane. 

To exclude users from the main Users and Workgroups Administration inteface: 

1. From the Workgroups pane, select a workgroup. 
2. From the Users pane, select a directory service user. 
3. Click the Remove (-) button at the bottom of the bottom of the Users pane. For directory service 

users, this automatically creates an exclusion in the directory service mapping that excludes the 
user from the workgroup. 
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About Extensis 

Contact Information 

Extensis 

1800 SW First Avenue 
Suite 500 
Portland, OR 97201 
Toll Free: (800) 796-9798 
Phone: (503) 274-2020 
Fax: (503) 274-0530 
http://www.extensis.com 

Extensis Europe 

Suites 17 &18, Newton House 
Northampton Science Park 
Kings Park Road, Moulton Park 
Northampton 
NN3 6LG  
United Kingdom 
Phone: +44 (0)1604 654 270 
Fax: +44 (0)1604 654 268 
info@extensis.co.uk 

Celartem, Inc. 

Phone: +81 3 5574 7236 
Email: sales_ap@celartem.com 
http://www.celartem.com/jp/ 

Customer Service 

Web: http://www.extensis.com/customerservice/ 
Phone: (800) 796-9798 

Corporate Sales 

Web: http://www.extensis.com/corporatesales/ 
Phone: (800) 796-9798, ask for Corporate Sales 

Documentation Feedback 

Web: http://www.extensis.com/helpfeedback/ 
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Technical Support 

Technical Support is available directly through the Extensis website or by telephone. 

When contacting technical support, include the following information:  

• Your serial number(s) 
• Your computer configuration, including operating system, memory, hard drive configuration, etc. 
• Your question or a description of the difficulty you’re experiencing - what specifically occurs and 

when  
• Your phone number if you want to have our representatives call you.  

Take note of any error numbers or messages that display and any other information you think may be 
relevant. 

For answers to frequently asked questions and troubleshooting tips, you can also visit the Extensis website: 
http://www.extensis.com/typeserver/  

Priority Support  

If you have an Annual Service Agreement, you are entitled to priority support. Please call the telephone 
number listed on your agreement to receive support 24 hours a day. 

Online Support  

To obtain support online, please fill out the online support form at  

http://www.extensis.com/support/  

Our tech support representatives will respond by phone or e-mail, usually within 24 hours on weekdays.  

Telephone Support  

In North America, please call (503) 274-7030  

In Europe, please call +44 (0) 1604-654-270  

http://www.extensis.com/typeserver�
http://www.extensis.com/support�
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The fine print 

© 2010 Extensis, a division of Celartem, Inc. This document and the software described in it are copyrighted 
with all rights reserved. This document or the software described may not be copied, in whole or part, 
without the written consent of Extensis, except in the normal use of the software, or to make a backup copy 
of the software. This exception does not allow copies to be made for others. Licensed under U.S. patents 
issued and pending.  

Extensis is a registered trademark of Extensis. The Extensis logo, Extensis Library, Font Reserve, Font 
Reserve Server, Font Vault, and Font Sense, Portfolio, Portfolio Server, Suitcase, Suitcase Server, 
Universal Type, Universal Type Client and Universal Type Core are all trademarks of Extensis. Portfolio 
NetPublish, NetPublish, Universal Type Server and Type Server are registered trademarks of Extensis. 
Celartem, Celartem, Inc., and the Celartem logo are trademarks of Celartem, Inc. Adobe, Acrobat, Illustrator, 
Photoshop, and PostScript are trademarks of Adobe Systems, Incorporated. Apple, AppleScript, Bonjour, 
Macintosh, Mac OS X, and PowerPC are registered trademarks of Apple Computer, Inc. Microsoft, Internet 
Explorer, Windows, Windows Vista, Windows XP, and Windows 2000 are registered trademarks of Microsoft 
Corporation. Intel is a registered trademark of Intel. Java and the Java Powered logo are trademarks or 
registered trademarks of Sun Microsystems, Inc. in the U.S. and other countries, and are used under 
license. Quark and QuarkXPress are trademarks of Quark Inc. All other trademarks are the property of their 
respective owners.  

Extensis warrants the disks on which the software is recorded to be free from defects in materials and faulty 
workmanship under normal use for a period of thirty (30) days from the original date of purchase. If you 
purchased this product directly from Extensis, and if a defect occurs during the 30-day period, you may 
return the disks to Extensis for a free replacement. All products submitted for replacement must be 
registered with Extensis before replacement. Extensis products purchased from resellers are warranted by 
the reseller and are covered by the reseller’s return policy. This warranty is limited to replacement and shall 
not encompass any other damages, including but not limited to loss of profit, and special, incidental, or other 
similar claims. This software is provided on an “as is” basis. Except for the express warranty set forth above, 
Extensis makes no other warranties, either explicit or implied, regarding the enclosed software’s quality, 
performance, merchantability, or fitness for a particular purpose. 
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